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Manage Money in Your Own Style!
Whether you are a paragon of organization or a little more fiscally relaxed, and whether you 
want to track every penny or just get your bills paid faster, Money works the way you do.
If your favorite thing about personal finance is that you’ve never paid attention to it and still 
never been arrested, great. You can spend less time than ever taking care of your finances 
when you use Microsoft Money. And if you enjoy following your financial picture carefully, you 
will find more ways to track it and look at it in Money than you probably ever imagined.
This book will take you beyond the simple ‘press-this-to-see-that’ approach you might have 
seen in other computer manuals. Instead, think of this book not just as instructions for some 
software, but also as a useful guide that will help you understand your finances and make it 
easier to manage them. 
One more thing: Don’t let the size of this book fool you. Money is a big program, loaded with 
special features. But because it’s easy to use, you don’t need a reference the size of a 
dictionary to figure out what’s going on. If you do need extra help, though, online Help is 
always available from within Money to guide you one step at a time through any procedure.
Regardless of your personal financial style, you probably share our philosophy when it comes 
to using the computer to handle your money: It ought to save you time, or it’s not worth doing.



Installing Money
Ready, setup, go!
Installing Microsoft Money is a simple process. In fact, if you purchased a 
computer with preinstalled software, Money might already be installed on your 
machine. If it’s not, you can install it in minutes.

To see whether Money is 
already set up and ready to 
go:

Click the Start button, then 
click Programs. Look for “Microsoft 
Money” in your list of installed 
programs.
If Money is not already installed, no 
problem.
To install Money:
1 Click the Start button, point to 

Settings, then click Control Panel.
2 In the Control Panel window, 

double-click the Add/Remove 
Programs icon.

3 On the Install/Uninstall tab in the 
Add/Remove Programs Properties 
dialog box, click the Install 
button.

4 Follow the instructions that 
appear on your screen.

Starting Money
To run Money once it is installed:

Click the Start button, click Programs, then Microsoft Money.
The first time you run Money, you can take a tour that introduces you to Money features. 
Whether you have used Money previously, have been using Quicken, or are new to personal 
finance software, there is a tour of Money tailored for you. 
When you’ve completed the tour, Money offers you several options. You can:

Create a new file of your own. (See Creating an Account.)
Explore using the Money Sample file. (See Exploring Money.)
Open a file you used with a previous version of Money or Quicken. (See Converting From 

Quicken for details on converting a Quicken file to Money.)
TIP:Saving files.



Using Online Help
Good Help is easy to find . . .
Online Help contains specific, detailed procedures. Although this book provides 
a broad perspective of what you can do with Microsoft Money, at times this 
might not be enough. If you find that you need more detail, such as which keys 
to press and what information to enter, use online Help. 
Online Help contains specific procedures designed to guide you through any task you might 
want to perform in Money. It’s easy to find what you need in Help—use it as a learning tool, a 
troubleshooter, or just as a way to stroll through Money’s features to see what’s available.
You can approach Help in a couple of ways, depending on what you want to do.
To get Help related to what you’re doing right now:
You can get Help with screen elements in several ways:

For Help on the entire area, click the question mark at the top of the Money window. 
For Help on a field where you enter text, click in the field and then press F1.
For Help on a button or other screen element where you don’t enter text, right-click the 

item you are curious about, then click the What’s This button.
To browse through online Help:

On the Help menu, click Help Topics to see a list of the available topics organized 
according to Money’s main areas.
Help topics are arranged according to the tasks you perform in Money. You can double-click any
of the books in Contents to see the topics contained in that area, or use Index or Find to look 
for topics based on words or phrases.
The Help Index is much like a book index; topics are indexed according to the kinds of 
information they provide. Using the Find tab, you can search through all Help topics for every 
instance of a word you enter.
TIP:Even more help.
TIP:If you used Quicken before.



Printing Help Topics
If you are a printed-word kind of person, don’t despair. It’s still easy to get 
procedural help you can hold in your hand and mark up with notes and 
fluorescent highlighter pens. You can print any Help topic or set of Help topics 
easily.
To print Help topics one at a time:

Open the Help topic you want to print, then click Print Topic on the File menu at the top of 
the Help window.

or
Highlight the topic on the Contents tab, then click the Print button.

To print Help topics as a group:
Click Contents in the Help Topic window. Click to select a heading on the outline, then 

click the Print button to print all the subtopics in that section of the outline.



Exploring Money
Places to go, things to do
When you first open Money, you can take a brief tour of its features. After that, 
you might want to explore on your own. Click around: get the lay of the land. If 
you want to experiment on some real-life finances, open the Sample file, which 
contains a family’s complete financial story.
Once you’re in Money, notice that the name of your file appears in the title bar at the top of 
the Money window. The first screen you’ll see is Contents. From here, you can get to any part 
of your financial picture by clicking the area you want to see.

Here are some places you
might want to visit:
Account Register    As with 
a paper register, all the 
activity for an account gets 
recorded here. There’s an 
array of forms you’ll use to 
enter your transactions, and 
a register shows all the 
transactions you’ve entered. 
You can also balance your 
accounts from here.
Payment Calendar    When 
you have recurring 
transactions, such as bill 
payments and paycheck 
deposits, you can enter them
in the Payment 

Calendar. When a bill is due, Payment Reminder lets you know. You can then tell Money 
whether you want to go ahead and enter the transaction into the Account Register as it 
appears, alter it before you enter it, or not enter it at all.
Home Banking    This is where you’ll go to set up and use Money’s Online Services, which let 
you use your modem to electronically pay bills, download your bank statements, transfer 
money between accounts, and even order new checks. Even if you don’t use Online Services, 
you can use the Home Banking area to keep track of your bank’s phone number and address, 
and even jump to your bank’s Internet site.
Account Manager    Use the Account Manager to create accounts, delete accounts, and view 
all account balances in a single list. When you first set up your finances in Money, you’ll go to 
the Account Manager to set up your current bank and brokerage accounts.
Investment Portfolio    When you invest in stocks, bonds, mutual funds, and other 
investment vehicles, you’ll use the Investment Portfolio to track your current investment 
holdings. You can even update the market prices of your investments manually or 
electronically.
Report and Chart Gallery    Reports and charts provide a useful way to look at your financial 
status, see trends, summarize information, and provide others with information through 
printing and exporting.
Payees and Categories    Use this area to view a summary of all your payees, categories, and
subcategories, or details for any one of them.
Planning Wizards    Money’s Planning Wizards help you plan for your financial future. From 



the Loan Calculator to the Retirement Planner, the Planning Wizards can be an enlightening 
way to do “what-if” planning with your money.
The MoneyZone    If you have a modem, an Internet browser, and Internet access, click the 
MoneyZone button to go to the Money home page on the World Wide Web. The MoneyZone 
provides answers to your questions about Money, financial-management tips, upgrade 
information, and even links to the Web sites of participating banks. You can also go to the web 
site directly from your Internet browser by entering the address 
http://www.microsoft.com/MoneyZone/



Money Top Ten
Ten great ways Money makes life easier. 
Check them out!

1 Online Services: Pay your bills, receive your bank statements, transfer funds, and
update your investments electronically. (More in Checking Out What Online 
Services Can Do For You)

2 Right-click menus: Save your wrists! Perform virtually any task by right-clicking 
the item you want to work with. (More in Navigating through Money)

3 Paycheck Wizard: Track your regular deductions (taxes, retirement contributions, 
and so on) automatically. (More in Entering Your Paycheck)

4 AutoComplete+ (More in AutoComplete+ Saves Time and Typing)
5 Retirement Planner: How much should you put aside per month so that you can 

take early retirement? Find out! (More in Using Wizards to Plan Your Savings)
6 Reports and charts: Instead of a mad scramble at tax time, you can just pull out 

your receipts and print a report. (More in Using Categories to Create Informative 
Reports, How Much Money Should I Keep in My Checking Account and Tracking Your
Investments: Using Charts)

7 No more tracking down math errors. Money updates your balances 
automatically and always remembers to carry the 1.

8 Payment Reminder: Never forget another “Payment due.” (More in No Need to 
Tie a String Around Your Finger)

9 Calculator: Compute automatically in any amount field. (More in Tips for Entering 
Transactions)

1
0

Three words: No More Stamps. (More in Paying Bills Online)

Navigating Through Money
Getting from here to there: 
Navigating through Money
When you first open Money, you'll see the Contents screen. From there, you'll 
click to go to one of Money's main areas, according to what you want to do (for 
example, paying bills or viewing a report). In addition, Money has incorporated 
several other features to help you get where you want to be and get there 
quickly.
In Money, you’ll always find the navigation bar at the top of the screen. You can use the tools 
on this bar to:

Switch to a different item in the current area (when available). 
Go to the Contents screen. 
Back up through the areas you’ve visited.
Go directly to another area.



Read Help topics about the current area. 
In addition to the navigation bar at the top of the Money window, three other tools help you 
navigate through Money: the magnifying glass, triangle menus, and right-click menus.

Magnifying glass    You can point to a place on a chart 
or report to get details on the data. As you hold the 
mouse over part of a chart or report, the pointer turns 
into a magnifying glass and additional information 
about the item appears.
If a plus sign (+) appears in the magnifying glass, you 
can also double-click to show the specific transactions 
that make up that section. 
Triangle menus    As you work in Money, you will often 
see a triangle next to a heading. On the Navigation bar, 
click this triangle to go to a like item within the current 
area. For example, if you are working in your checking 
account
in the Account Register, you can click the triangle menu to quickly switch to your savings 
account. 
Frequently, triangle menus appear within the window as well as in the Navigation bar. When 
you see a triangle in your Money window, click it and see what you can do.
Right-click menus    Right-clicking on just about any element within a window opens a menu 
listing everything you can do with that element. For example, if you right-click a check in the 
Account Register, you can use the menu to quickly make that check a Recurring Payment by 
adding it to the Payment Calendar. For screen elements that don’t have related activities, right-
clicking produces a What’s This button, which you can click to learn more about the item. Try 
it!
Startup location    By default, you’ll see the Contents screen each time you open Money. To 
change your startup location, click Options on the Tools menu. Then, on the General tab, select
the area you want.



How Do I Know What Accounts to Set Up?

Releasing the bean-counter within: 
Setting up and managing accounts
A good rule of thumb is to set up a separate Money account (but not a separate 
file) for each bank or brokerage statement you receive in the mail. Like all good 
rules, though, this one has some exceptions. The list below describes the most 
common types of accounts.
Checking Accounts    Chances are that you have one. Set up a separate Checking Account in 
Money for each checking account you use.
Savings Accounts    Use a separate Money account for each savings account you use. 
Investment Accounts    In general, create one account for each brokerage statement you 
receive. Then create a single Investment Account to hold miscellaneous investments you hold 
personally, for example, treasury bills and mutual funds you’ve purchased yourself that are not
part of a brokerage account. (For more detailed information on which Investment Accounts to 
set up, see Determining Which Accounts to Set Up.)
Retirement Accounts    Track your tax-deferred retirement savings with ease. Use this 
account type if you save for retirement using a 401(k), 403(b), IRA, SEP, Keogh, or RRSP 
account. 
Loan Accounts    Use a Loan Account to track amortized loans with a regular payment 
schedule, such as home mortgage loans. 
Asset Accounts    Track changes in your personal assets. You might want to keep records of 
improvements that increase the value of your house or track the value of a baseball card 
collection. Tracking your valuable possessions comes in especially handy if you ever need to 
make an insurance claim, or when you want to calculate your net worth.
Credit Card Accounts    This one is a little trickier. If you generally pay off your credit cards 
each month and don’t want to categorize your spending meticulously, creating a separate 
account is probably more work than it’s worth. But if you don’t pay off your cards each month, 
or you want to download credit card statements using Online Banking, you’ll want to create a 
separate account for any credit card for which you carry a balance. 
TIP:Assess your assests.



Creating an Account
No matter what kind of account you’re setting up, the basic steps are the same.
The New Account Wizard asks you questions, then sets the account up for you 
based on your answers.
After you’ve decided on an account type, the most important step in setting up a new account 
is entering a correct starting balance. Use the balance from an account statement. If you 
use the balance from your check register or call the bank for today’s balance, you won’t know 
what outstanding checks you need to account for. If you can’t find a statement right now, don’t
worry—you can change the account’s starting balance at any time in Account Details.
To create an account: 
1 Track down the statement for the month from which you want to start tracking the account 

and note its ending balance.
If you’re tracking for tax purposes, consider tracking from the beginning of the calendar 
year.

2 Go to the Account Manager, then click the New Account button.
3 Follow the New Account Wizard through the setup.

The wizard asks about the type of account you want to set up. If you aren’t sure of the 
account type, click a type in the list and read the description that appears in the dialog box.

4 When you’re done creating the account, you can go to the Account Register to enter 
transactions. Just double-click the account in the Account Manager.
Because you used a statement’s ending balance, you’ll enter only transactions that cleared 
the account after that statement was issued. Transactions included on that statement are 
already figured into the balance you entered.

TIP:Favorite accounts.



Entering Transactions
Once you have created an account, you can start entering transactions—checks,
deposits, withdrawals, ATM transactions, and so forth. If you’ve been using a 
paper register, the Money register should be familiar to you.
Entering a transaction in Money is much the same as entering one in a paper register, with two
important distinctions: You don’t usually have to enter as much information (read about 
AutoComplete+), and Money does the math for you, adding or subtracting the transaction to 
update the running balance.
By default, Money provides simple forms for entering transactions. The specific options in the 
transaction forms vary depending on the kind of account you’re using. 
To enter a transaction in an account:
1 Go to the Account Register and switch to the account. 

The last account you worked with appears automatically. To work with a different account, 
click the triangle to the left of the account name in the navigation bar.

2 In the form at the bottom of the screen, click the tab for the type of transaction you want to 
enter.

3 Enter the details of the transaction.
You can press   TAB   to move quickly from field to field  .  

4 When you’re finished, click the Enter button to enter the transaction in the register.
To read more about entering a transaction, look up “transactions” in the online 
Help Index.
TIP:Tips for entering transactions.
TIP:More tips.



Deleting a Transaction
To delete a transaction:

Highlight the transaction in the Account Register’s transaction list, then press Delete on 
your keyboard.



Transferring Funds Between Accounts
Sometimes a transaction is not between you and another person, but from one 
of your accounts to another. For example, you might pull money from savings 
into your checking account, or sell some stock in an investment and move the 
proceeds to your checking account.
When you have activity between accounts, you can take care of it in one transaction: a 
transfer. Money has a special form for transfers, which saves you the extra work of entering a 
deposit in one account and a withdrawal in another. 
Important: To enter a transfer from the Account Register, transaction forms must be
visible. If you’ve turned them off, display them again by clicking the triangle to the 
left of the view bar, then clicking Transaction Forms.
To transfer money between accounts:
1 Open one of the accounts in the Account Register.

It’s usually easiest to open the account you’re transferring from.
2 Click the Transfer tab.
3 In the From box, click the drop-down list to select the account you’re transferring from.

If you’re in that account already, Money selects it by default.
4 In the To box, click the drop-down list to select the account you’re transferring to.
5 Enter the rest of the information as usual. (You might want to leave the Pay To field blank.)

When you complete a transfer form, Money records the deposit and withdrawal in the 
appropriate Money accounts for you.

If you enter a transfer in Money, remember to transfer at the bank, too! Just as with a paper 
register, recording a transfer in a Money register doesn’t necessarily mean the money has 
been transferred.
If you use Online Services, you can transfer funds simply and easily from your computer. See 
Transferring Funds Online to learn about making an online transfer.



Closing Accounts
When you no longer use an account, you have two options in Money: you can 
close the account or delete it. If you close the account in Money, you can still 
review its records, but the account name no longer clutters up your lists. If you 
delete it, its records are permanently removed from your Money file.
When you close an account, its icon in the Account Manager shows that it is closed and Money 
no longer displays it on the drop-down list in the Account Register. However, you can still 
double-click the account in Account Manager to view the account and use it in charts and 
reports.

To close an account:
In the Account Manager, right-click the account you want to close, then click Account is 

Closed.
If you don’t want to see closed accounts in a report or chart, you can exclude them by clicking 
the Customize button in the report or chart.



Deleting an Account
You can also delete an account completely from your Money file. When you delete an account, 
you remove all of its records from your file, and any transfers between the deleted account and
remaining accounts read “Xfer to Deleted Account” in the Category field. 
It’s a good practice to save a backup of your Money file before you delete an 
account, in case you ever want to review that account. 
To Delete an account:

In Account Manager, select the account, then click the Delete button.



Using Categories to Create Informative 
Reports

Categories tell the story
Categories make the difference between simply knowing how 
much money you have and actually knowing where your money 
is going. If you want to track the percentage of your income 
that goes to housing or see how your grocery bill has shrunk 
since your kids moved out, categories are for you.

Assigning categories to every transaction puts a whole world of information at your fingertips. 
Use this information to give your financial story to...

Yourself    Creating charts by category can help you figure out where your money is going so 
that you can decide whether—and where—you want to make adjustments. 

Your tax advisor    Because every category and subcategory is marked as either tax-related 
or not, it’s easy to compile the numbers you need at tax time. You can even export the report 
so that you can use its information in your tax-preparation software. 



Your family    It’s easy to create a reasonable budget when you can see what you’re currently 
spending. And comparing your actual figures to the budgeted ones lets you see exactly how 
you’re doing.



Cash Cards: Dream Come True 
or Categorizing Nightmare?
In 1994, Americans used ATMs an average of 4.5 times a month, withdrawing an average of 
$66 on each visit. That’s $3,564 a year down that black hole marked “Miscellaneous.”
Of course, it’s perfectly fine if you don’t know where your ATM cash goes. It’s only an issue if 
you want to keep careful track of how you spend your money. If you find yourself wanting to 
know where more of your money goes, try the following:

Use your card to make direct purchases. Many banks now call their cards “check 
cards” or “debit cards.” These cards not only work at standard ATM machines, but can also be 
used at grocery stores, gas stations, and other locations. Instead of getting cash from the 
machine and then spending it on groceries or gas, use the card to make the purchase. The place 
you used the card will show up on your statement, making it easier for you to categorize the 
expense. 

Use the cash machine on an as-needed basis only, such as if you need fast cash to
go to a movie. Avoid withdrawing more than you need—it’ll be easier to keep track if you use the 
machine only for specific purposes.

Give yourself a weekly allowance (you could even create an Allowance category), 
and then leave your ATM card at home. Or, to track even more closely . . .

Create a Cash Account in Money, then enter ATM withdrawals as transfers to the 
Cash Account. Save your cash receipts, and enter them later in the Cash Account. Talk about 
thorough!



Setting Up Categories and Subcategories
Money provides several standard categories and subcategories that will get 
you started. It’s also easy to set up your own categories. Whenever you 
assign a category that Money doesn’t recognize, Money makes that category 
a part of your permanent list.
To create a new category or subcategory:
1 While entering a transaction in the Account Register, type a new name in the Category or 

Subcategory field.

2 Press tab.
The Create New Category/Subcategory dialog box appears. You can change the name or 
type of category or subcategory, and indicate whether you want it to be included on tax 
reports.

If you type a category or subcategory that’s already part of Money’s Standard Categories, 
Money fills in the full name for you after you type the first few letters. You can also type your 
subcategory name in the Category field, and Money will fill in the appropriate category and 
subcategory for you. If you want to remove one of Money’s Standard Categories, follow the 
steps in Deleting Categories and Subcategories.
TIP:To recategorize a group of transactions.



Deleting Categories and Subcategories
If you want to remove categories you aren’t using, you have two choices: 
remove categories individually, or remove all categories that aren’t assigned to 
any transactions.
To take a look at the categories that are currently available, click Payees & Categories from the
Contents screen. In the Payees and Categories area, click the Categories button. Use the 
buttons at the bottom of the window to modify, add, or delete individual categories.
If you don’t want unused categories cluttering up your window, it’s easy to remove them as a 
group.
To remove unused categories as a group:
1 Click Options on the Tools menu, then click the Categories tab.
2 Click the Remove button. Removing categories won’t affect the way any existing 

transactions are recorded; Money removes only those categories that aren’t assigned to 
existing transactions.

If, after removing categories, you decide you’d like to use Money’s Standard Categories after 
all, it’s easy to reinstate them. Simply go back to the Categories tab and click the Add button.
Note: When you reinstate categories, Money replaces its Standard Categories only. You can re-
create your own categories simply by typing them into a Category field as you need them.



Splitting a Transaction
So you’ve decided to make use of the wealth of charts, reports, and financial 
enlightenment that comes with assigning categories to your transactions. But 
what do you do if a single transaction belongs in several categories? Simple: 
split the transaction.
When you split a transaction, you are simply assigning parts of it to different categories. This 
means that you can enter a single $100 check to Super MegaStore, but categorize $40 of it as 
groceries and $60 as garden supplies. Other uses of split transactions include:

Recording a single deposit that includes several checks or checks plus cash.

Depositing part of a check and taking some of it back in cash.

Splitting a loan payment into principal and interest (if you opt not to set up a 
separate Loan Account).
To split a transaction:
1 Fill out a transaction form as usual, but don’t enter a category. Instead, click the Split button.

If you’re entering the transaction directly into the register, enter Split as the category.

The Split window gives you room to enter different categories for different parts 
of a transaction. Here, several checks are deposited and $100 is taken as cash 
received. Using this method, you can record both the deposit amount and the 
amount of each check correctly.

2 For each portion of the split, enter the category, subcategory, description, and amount. If 
you’re taking cash back from a deposit, type a minus sign (-) before the amount.

3 To move down one line, press TAB, or double-click the next line.
4 When you’re finished, click the Done button to enter the split and return to the Account 



Register.
When you split a transaction, the word “Split” appears in the Category field. To view the splits, 
click the Split button.
TIP:To apportion a leftover amount when splitting a transaction.



Entering Your Paycheck
Taxes, contributions to retirement accounts, and even childcare costs are 
routinely deducted from paychecks. How do you keep track of money you never 
even see? Use the Paycheck Wizard. 
Rather than simply entering the amount of your paycheck (your net pay) as a deposit, you can 
use this wizard to categorize your total pre-tax pay (your gross pay) as well as the deductions 
taken from it. 
To enter your paycheck deductions:
1 With a pay stub for reference, enter a deposit.
2 In the Category field, enter Paycheck.
Money launches the Paycheck Wizard, which walks you through creating the split transaction. 
Once Money has set up the split categories, you just need to enter the appropriate amounts on
each tab.

In the Paycheck dialog box, each deduction has its own tab. To enter or edit a 
specific deduction, click its tab. The totals at the lower left reflect the information 
you enter on each tab.
To enter your paychecks in the future, simply enter your employer name (or My Paycheck, or 
whatever you used as the payee the first time) in the Pay To field. When you tab to the next 
field, Money enters the information from the previous paycheck deposit automatically. To see 
the breakdown of your deductions, click the Split button.



Self-Employed?
If so, you’re part of a growing group of Americans whose payroll deductions aren’t managed for
them. And when April 15 looms, it can be difficult to find the funds. Here’s a way to ensure that
you set money aside for taxes and for your own retirement. The following overview will give 
you the idea; for clarification on specific steps, see the related sections in online Help or in this 
manual.
1 If you don’t already have one, open a savings account in which you can set aside the money

for your income tax and FICA payments.
2 Use the Payment Calendar to set up a recurring transfer to your savings account, then 

remember to transfer the money. If you use Online Bill Payment, set the transfer up as a 
recurring payment to your savings account.
Even if your paychecks don’t arrive on a schedule, using the Payment Calendar will remind 
you to take out your deductions. Set up a frequency that makes sense for you: maybe you’ll 
end up skipping a payment or two, or maybe you’ll deduct from several checks each time.
Use Money’s calculator to determine the amount of the payment: in the check form, enter 
the amount of the paycheck and multiply it by your tax rate (for example, .28 for 28%). 
When you press ENTER, the amount of the payment will be correct for the current paycheck.

3 Also in the Payment Calendar, set up regular bill payments to your IRA, SEP-IRA, or other 
retirement account.

Whether you make your tax payments quarterly or annually, if you use this system, you’ll be 
sure to have enough set aside. And if you “withhold” at your actual tax rate, you’ll probably 
have some savings left over once you figure your deductions at the end of the year.



Writing a Check

The check is in the mail: 
Managing your checking accounts
In less time than you spend managing a paper check register, you can use 
Money to track your checking account, gain new insights into where your 
money is going, and pay all your bills on time without ever licking a stamp. 
You can use Money to track your checking account just as you would use a paper register. But 
before long, you’ll probably find that you want to take advantage of Money features that take 
you above and beyond simply writing out and recording checks. 
In most ways, your checking account is like any of your other Money accounts. You can enter 
transactions, categorize them, and create charts and reports that offer you different 
perspectives on what’s going on in the account. 
If you know how to write a check in a paper checkbook, you know how to enter a check in 
Money. It is that simple. But Money gives you four options for what kind of check to write. 

You can write checks 
using...

And here’s how you do it...

A paper checkbook, just like 
you always have

Write the check by hand and record it in the 
Money register. Money keeps track of the running 
balance for you. 

Printed checks Enter the check, and then print it. Money records 
it in the register automatically, saving you the 
dual task of writing a check and writing in the 
register. Then you still sign the check, put it in the
envelope, and stick it in the mail. For more 
information, click Ordering Checks on the Help 
menu.

Online Bill Payment Write the check out in Money, and choose Epay 
instead of entering a check number. Use your 
modem to connect to Online Services. Money 
automatically enters the check in your register, 
and tracks when the check is sent and when it 
clears.

Automatic Payment In the Payment Calendar, enter a Recurring 
Payment that is always the same amount (such 
as a mortgage payment), and choose Apay 
instead of a check number. Use your modem to 
connect to Online Services. Once you set up an 
Automatic Payment, the payment occurs at the 
frequency you specify. See Paying Bills Online for 
more information.

Getting More With Less



The following hints can help you minimize the work you do and maximize the benefits you get 
from using Money to manage your checking account:
For checks you write when you’re out and about

Order carbon-copy checks, and save yourself the dual recording task of entering 
checks in a paper register and then on the computer. (Remember that you’re making a tradeoff, 
though: Carbon copy checks are usually more expensive.)

Even better: Use a debit card for purchases when you can. It’s like writing a check,
but you don’t have to write. Remember, though, that when you make a debit card transaction, 
the money is usually taken out of your account the following business day; you don’t have a few 
days of lag time as you frequently do with checks.

Combine debit card transactions with Online Banking for the least work of all. With
Online Banking, your debit card records are entered with the click of a button. An additional 
incentive: When you use a debit card, you sometimes get a rebate (in contrast to checks, which 
you have to buy). 
For checks you write at home

Use Online Bill Payment to send checks from your computer to anyone in the 
United States. Just enter the payment amount, then use your modem to tell the payment service 
whom to pay and when. You can use Online Bill Payment with your current checking account—
even if your bank doesn’t provide other electronic services.

In addition to saving time, you’ll also probably save money with Online Bill Payment. Specific 
fees vary from bank to bank, but you can usually send more bills for your money when you 
pay online than when you buy your own stamps and checks. To find out what your bank 
charges for Online Bill Payment, go to the Home Banking area and click Set up Online 
Services.

Print checks directly from Money. (Another tradeoff: printer checks are more 
expensive than regular checks.)



For regularly recurring bills, use the Payment Calendar. You only need to fill out the
check once; Money reminds you when it’s due, gives you a chance to make changes, then 
automatically places the entry in your register and does the math.
And the winner is...
All of the tips above will help you save time or money in different situations. But when it comes
to paying bills, the combination of the Payment Calendar (as your check-entry method) and 
Online Bill Payment (as your check-delivery method) takes the prize.



Printing Checks
Using Money to print checks can save you time when paying bills. It also saves 
you time in recordkeeping, because typing the transaction once enters it in 
your register and prints it on your check.
Money prints check information on special blank checks you use in your printer. For order 
forms and additional information on ordering checks, click Ordering Checks on the Help menu. 
Printed checks work with any checking account. Yes, even yours.
When you want to print checks, you’ll follow a three-step process of entering transactions with 
"Print" in the number field, loading checks in your printer, and then printing the checks. But 
first, you need to set Money up for the kind of checks you’re using.
To set up to print checks:
1 On the File menu, point to Print Setup, and then click Check Setup.
2 In the Printer box, choose a printer from the list.

If your printer is not in the list, you need to install it in Windows. See your Windows 
documentation for instructions.

3 Under Check, choose the type of check you want to use and click OK.
Money can print checks that you ordered to use with Quicken. If you converted a 
Quicken file from which you printed checks, Money adds Quicken check types to the Check 
Setup dialog box. 

4 If you want to modify additional printer settings, choose Options from the Tools menu, and 
then click the Print Checks tab.

TIP:Printing checks.



How Much Money Should I Keep 
in My Checking Account?
As a general guideline, it’s a good idea to keep your balance high enough that you aren’t 
bouncing checks or paying unnecessary fees, but low enough that you don’t have a bunch of 
extra money just idling away in there. Ask yourself these questions to help you decide if you’re
keeping the right amount in your checking account.

Do I frequently worry about bouncing checks?

Does my account have a minimum balance, and have I been paying service 
charges for falling below that minimum?

Do I have enough money in my checking account to cover more than two months’ 
expenses?
If you answered yes to any of the above questions, you might want to adjust the amount of 
money you keep in your checking account. To find a good range, first determine a minimum 
amount. Maybe it’s the threshold at which the account has a fee, or just an amount you feel 
comfortable with as a cushion. When you fall below that threshold or hover near it for a period 
of time, you’ll know it is time to:

Transfer money from savings (see Transferring Funds Between Accounts, or 
Transferring Funds Online if you use Online Banking).

Create a budget and/or cut spending (see Setting Up a Budget Based on Your 
Spending History for details).



Find more money—even a bank loan is likely to cost less than check-bouncing 
fees.
Similarly, create a maximum threshold over which your money could be working better for you 
in another account. Even if your checking account earns interest, the rate would likely be 
better in a savings account at the same bank. When you stay above your maximum balance 
for a few months, you’ll probably want to transfer some money to savings or an investment. 
Use the Account Balance History chart to help you determine whether your account balance is 
generally too low for safety or too high to make the best use of your money.

Use the Account Balance History report to see trends in your checking account at a glance. 



Checking Out What Online Services 
Can Do for You

Look Ma, no hands! Surf your 
accounts with Online Services
Online Services redefine convenience when it comes to 
your finances. Once you’re wired, you’ll never yearn for 
the “good old days” of teller lines and Hold music. All you 
need to get started is a modem.

With Online Services you can electronically pay any business or individual, bring records of 
cleared transactions from your bank directly into your computer, and automatically update the 
prices for all your stocks and mutual funds. You can even connect to your bank’s Internet site, 
if it has one, and check its current offerings.
You can use Money’s Online Services in any combination. Use the table below to figure out 
which services you want to use and what you’ll need to use them.

Use... When you want to... Here’s what you need
Online 
Banking

Download your statement 
information. With the click of a 
button, find out your current 
balance and retrieve information
on your cleared checks, and give
instructions, such as fund 
transfers or check orders.

A modem and an account at a 
participating financial institution 
(bank, credit union, and so on). More
and more banks offer Online Banking
every month. To find out if yours is 
one of them, click the Set up Online 
Services button in the Home Banking
Area.

Online Bill 
Payment

Pay all your bills from your 
computer, and schedule your 
payments up to a year in 
advance. No more addressing 
envelopes and licking stamps.

A modem and a checking account at 
any financial institution in the United
States.

Online 
Quotes

Electronically update the prices 
for your stock and mutual fund 
investments.

A modem. 

The 
MoneyZon
e

Learn about upgrades, tips and 
tricks for using Money, and get 
your questions answered by the 
experts.

A modem, a web browser, and 
Internet access. 

Online Banking and Online Bill Payment are frequently used in conjunction, and are discussed 
on the pages that follow. For information on Online Quotes, read about updating investment 
prices. 



Signing Up for Online Services
Before you take the leap and sign up for Online Services, Money gives you the 
chance to use your modem to learn about the Online Services your bank offers, 
including the cost of the services and how to sign up. Just click the Set up 
Online Services button in the Home Banking area to make the toll-free call.
Depending on your bank, you might be able to sign up for Online Banking and Bill Payment and
use them right away, or you might need to wait a day or two. Your bank will let you know.
You can set several accounts up for Online Banking, including accounts at different banks.
Note: If you’re planning to set up more than one account, set up your checking 
account first. 

TIP:Give Online Banking a try!
To sign up for Online Services:
1 Gather your materials.

To sign up a checking account, you’ll need to know the bank’s routing number (the first nine 
digits printed in the lower-left corner of your checks). For credit cards, you’ll need the card 
or a copy of your statement. 

2 Go to the Home Banking area for the bank you want to use for Online Services.
To switch between banks in the Home Banking area, click the triangle next to the bank name
in the navigation bar.
If the bank name is missing If you have converted your file from Quicken or a previous 
version of Money and your bank’s name wasn’t included in the original file, you need to add 
it now. Go to the Account Manager. For each account, click the Account Details button and 
enter the name of your bank. When you’re done, go back to the Home Banking area.

3 On the Accounts tab, click Set up Online Services.
4 Follow the instructions on your screen.
TIP:Where to go for help.



Are Online Services Safe?
Yes.
If you’re like many people, you might feel a little queasy about entrusting your banking to your
computer and your phone line. 
Rest assured. Using Online Services to access your accounts is as safe as using an ATM card. 
The technology used for your Online Services password is similar to the PIN technology used 
for ATM machines, and all the information transmitted during an online session is encrypted as 
it’s transferred. In order to use your Online Services, someone would need to have access to 
your Money file or an account statement, as well as knowledge of your online password. 
The most important part of your online security is something you control yourself: your online 
password. For greatest security, don’t share your password, don’t store it near your computer, 
and don’t use a password that’s easy to figure out (no kids’ names or birthdays). 
For additional security, you can also add password protection to your Money file. For 
instructions, look up password in the online Help Index.



Getting to Know the Home Banking Area
Once you’re signed up for Online Services, more tabs appear in the Home 
Banking area according to the services you have. Take a minute to click through
these tabs and familiarize yourself with them.

To switch to a different bank, click the arrow, then choose a bank from the list.

When you’re ready to connect to Online Services, use the Connect tab. This tab 
appears if you are signed up for either Online Bill Payment or Online Banking.

Use the Statements tab to read the transactions that have cleared your online 
accounts. This tab appears only if you’re signed up for Online Banking.

Check the status of your Electronic Payments on the Payments in Progress tab, 
which appears only if you’re signed up for Online Bill Payment. 

Use the Accounts tab to set up an account for Online Services, or to change the 
setup of your existing services. This tab is always available.

The Contact Information tab lists the Customer Service phone number and 
other information about your financial institution.
Using Online Services is a three-step process. First, you prepare the instructions (such as 
payments, transfers, and letters to your bank) that you want to send. Second, you use your 



modem to call Online Services. Third, you review the information sent back to you. These 
steps are discussed in more detail on the following pages.
TIP:Use Online Banking to communicate with your bank.



Step 1: Preparing Online Instructions
Paying Bills Online
You can eliminate writing the same check month after month, stuffing 
envelopes, and searching for stamps by paying your bills online. When you use 
Online Bill Payment, you’ll enter your payment information as usual, then call 
Online Services to send the payments through your modem.
Electronic Payments (Epays) let you make payments to anyone in the United States by 
entering the transaction in Money and sending it through your modem. If the person or 
business can’t receive payments electronically, the payment service simply mails a check.
Automatic Payments (Apays) are as simple as it gets for bills that have a fixed frequency 
and amount. You set up an Automatic Payment once. From then on, Online Bill Payment 
automatically makes the payment each time it’s due. Monthly rent, car loan, and mortgage 
payments work well with Automatic Payments. (Apay availability depends on your bank.)

To pay your bills online:
1 Create the payment in Money.

You can enter Epays from the Account 
Register, Payment Calendar, or the 
Connect tab in the Home Banking 
area. You can enter Apays from the 
Payment Calendar only.

2 Enter your payment information as 
usual, except: in the Number field, 
enter Epay or 
Apay, depending on the type of payment you want to create. In the Date field, enter the 
date by which you want the payment to be received. The first time you enter an Epay or 
Apay for a payee, Money asks you for the payee’s address.
When you enter an Apay, Money also asks you for a frequency and a time limit for the 
payments (for example, every month for a year).

3 Repeat steps 1 and 2 until you’ve entered all the payments you want to send. If you are 
working from the Payment Calendar, click to choose the payments you want to send, then 
click Enter to enter the payments into the Account Register.

4 Click Home Banking. 
5 Follow the steps in Calling Online Services to connect to Online Services and send the 

payments.
The most important thing to remember about Apays compared to Epays is that once 
an Apay is set up, payments are sent even if you don’t connect to Online Services. 
So be sure to keep enough money in your account to cover all payments.



Step 1: Preparing Online Instructions
Transferring Funds Online
If you sign up for Online Banking, you can transfer money between two 
accounts by entering the transfer, then connecting to your bank to send the 
transfer instructions. Online transfer capabilities vary from bank to bank—check
with your bank to see whether you can transfer money to another person’s 
account and between accounts at different banks.
Depending on the time of day you send an online transfer, the funds will be transferred either 
that day or on the next banking day. However, remember that the money isn’t actually 
transferred until you connect to Online Services and send the instructions. 
Some banks will also let you create transfers for future dates. For example, you might know 
your checking account is going to be low on the first of the month (use the Balance Forecast 
chart in the Payment Calendar to predict future balances), so you could create a transfer from 
savings for that date.
To set up an online transfer:
1 Enter the transfer in Money. You can enter Electronic Transfers (Xfers) from the Account 

Register or the Home Banking area.
2 In the Number field of the transaction form, enter Xfer.
3 If you entered the transaction from the Account Register, click Home Banking. 
4 Follow the steps in Calling Online Services to connect to Online Services and send the 

transfer.



Step 2: Sending Online Instructions
Calling Online Services
Whether you use Online Bill Payment, Online Banking, or both, you can take 
care of all your online transactions with a phone call. You can connect to Online 
Services whenever you want.
When you call Online Services, Money transmits all the instructions listed in the Home Banking 
area. To switch between financial institutions in the Home Banking area, click the triangle next 
to the bank name in the navigation bar.
To connect to Online Services:
1 Make sure the transaction list contains all the transactions you want to send. (See the 

procedure in Excluding a Transaction From a Call for excluding instructions that are on the 
list.)
The list contains any Electronic Payments, Automatic Payments, and Electronic Transfers you
have entered but that have not yet been sent to your bank. The list also contains 
instructions to update the transaction and balance information for the accounts you have 
set up for Online Banking at that bank.
If you want to send an electronic letter to your bank, such as a check order or inquiry, or 
other instructions, click Write Letter.

Everything listed here will be sent during the call to Online Services.
2 Click Connect.
3 Type your password in the Call Online Services dialog box.

The first time you connect to Online Services, you’ll use a password provided by your bank. 
Change this password to one you’ll remember.

4 Click the Connect button, then wait while Money and your bank exchange information.
When the information has been transferred, Money disconnects from your bank. 

When the call is complete, The Call Summary dialog box lists everything that happened during 
the call, and includes the answers to any electronic letters you might have sent recently. If you 
want to keep records of your calls to Online Services, you can save the information in the Call 
Summary box as a text file.
Note: If you use Online Services for accounts at more than one bank, you’ll need to make a 
separate call for each bank. (It’s similar to an ATM card; while you can access several accounts
with one card, all of those accounts must be at the same bank.)
TIP:How often should you connect to the bank?



Step 2: Sending Online Instructions
Excluding a Transaction From a Call
To exclude a listed transaction from a call to Online Services:

Right-click the instruction on the Connect tab, then click Don’t Send on Next Call.
Unless you exclude it again, the instruction will be sent the next time you connect. 

When you exclude an instruction, Money dims it in the Transaction list and 
does not send it on the next call.
If you want to cancel an Epay, Apay, or Electronic Transfer completely, see Canceling Electronic
Transactions.



Canceling Electronic Transactions
You can delete Epays, Apays, and Xfers before you’ve connected to Online Services just like 
you delete any other payment. See Deleting a Transaction for instructions on deleting a 
transaction from the Account Register, or Modifying Payment Calendar Transactions to delete a 
payment from the Payment Calendar.
You can also cancel electronic transactions after you’ve connected to Online Services and sent 
the instructions, as long as Online Services hasn’t actually completed the transaction yet. 
Simply right-click the transaction in the Account Register, point to Mark As, then click Void. 
When Money asks if you want to cancel the payment, click Yes.
Next, you need to send the cancel instructions by connecting to Online Services as usual. 
When you’re finished, you’ll see the instruction to cancel listed in the Call Summary dialog box.



Step 3: Reading Statements
Entering Downloaded Transactions
A big advantage of Online Banking is that it lets you electronically download 
transactions directly from your financial institutions into your Money Account 
Register. Simply put: no more typing transactions.
Without Online Banking, keeping accurate records means that you need to enter every ATM 
withdrawal, deposit, and handwritten check manually into the Money Account Register 
(Remember, checks you send with Online Bill Payment or print from Money are entered for you 
already.) With Online Banking, you can stop typing and instead connect directly to your bank to
enter your transactions electronically. You’ll still probably want to categorize the transactions 
and perhaps add other information, but the critical numbers are entered for you. Also, you’ll 
still receive your paper statements in the mail, but you’ll probably use them only to balance 
your account for the statement period.
If you prefer, you can continue entering your transactions manually. When you connect to your 
bank, Money matches what you’ve entered to what’s cleared the bank, so nothing gets 
entered twice.
If you don’t enter transactions manually, keep in mind that your Account Register will show 
only those transactions that have cleared the bank. If you don’t keep track of your ATM 
withdrawals, deposits, and handwritten checks, you won’t have a record of what’s still out 
there that hasn’t cleared. 
Once a statement is downloaded into Money, you enter the downloaded transactions into your 
Account Register. Money automatically matches the downloaded transactions to those you’ve 
entered manually. 
You can read the transactions on your downloaded statement immediately after your call is 
complete, or wait until later. Money saves the statements until you’re ready to go through 
them.
To see which accounts at a particular bank have unread statements, go to the Home Banking 
area and click the Statements tab for that bank. 

The “Statement contains” column shows how many downloaded transactions are 
ready to be entered into your Account Register.

To read downloaded transactions:
1 On the Statements tab in the Home Banking area, highlight an account containing one or 

more unread transactions and click Read Statement.
Money lists all the transactions that have cleared your bank since you last connected.

2 Click Update Account Register.



One at a time, Money lists the transactions on your downloaded statement so that you can 
review them before adding them to your account register.

If the electronic statement contains transactions that nearly match existing entries in your 
register, Money displays the downloaded transaction along with the matching transaction. You 
can then confirm the match, or indicate that the transactions are separate. 

When Money does not find a match for a bank transaction, it displays as much as it knows about 
the transaction. You can then enter more information; for example, you might want to categorize 
a check, or use a Split transaction to list a deposit according to the checks it included.

3 Click the Next button.
When you click Next, Money marks transactions as cleared by entering an E in the cleared 
field in the Account Register. This makes it easy to spot transactions that have been verified 
electronically. When you balance your account, Money changes all Es to Cs.

4 Continue completing the transaction forms and clicking Next until you’ve reviewed all the 
downloaded transactions.
If you don’t want to review all the transactions now, click Postpone. To resume reading the 
statement, go to the Statements tab in the Home Banking area and click the Read 
Statement button again.



When you have finished reviewing the transactions from your bank, you can view them right in 
your Account Register, just like those you enter manually.

TIP:Changing your Online Services.



Keeping Tabs on Your Online Payments
To check the status of transactions sent using Online Bill Payment: 
1 After you’ve read and closed the Call Summary dialog box, click the Payments in Progress 

tab.
2 Highlight a payment and click Payment Status to view its details.



The MoneyZone
Have questions about Money? Want to learn the cool tricks that other Money 
users have discovered, or pose a Money puzzler to Dr. Money? Get yourself to 
the MoneyZone, fast.
How you get to the MoneyZone depends on the Internet software you use.
If you use Microsoft Internet Explorer, Netscape Navigator, or a compatible web 
browser, you can go straight to The MoneyZone by clicking the MoneyZone on your Money 
Contents screen.
If you have a web browser through a larger online service, such as America Online, 
CompuServe, or Prodigy, you can get to the MoneyZone from within your service’s web 
browser. Connect to your service, go to the web browser, then enter the address 
http://www.microsoft.com/MoneyZone/
If you don’t have a web browser or Internet access, you can sign up for a free, 30-day 
trial of the Microsoft Network, which includes Microsoft Internet Explorer. Just click the Internet 
button on your Windows 95 desktop to sign up and get started.



Scheduling Payments

Time bills perfectly using 
the Payment Calendar
If you’re like most people, you have a set of transactions you make every month
—a paycheck deposit, the phone bill payment, and so on. After making these 
transactions regularly for months or even years, it seems as if it ought to be 
automatic. With the Payment Calendar, it is.
The simplest way to manage recurring bills and deposits is to enter them in the Payment 
Calendar. Once you enter a transaction and specify how often it occurs (for example, once a 
month), you never need to type the information again. In addition, Money’s Payment Reminder
lets you know when bills are due, even if you’re not using Money.
TIP:No need to tie a string around your finger.
To add a new transaction to the Payment Calendar:

Go to the Payment Calendar and click the New button.
Money walks you through the steps necessary to create a recurring transaction.

You can also add transactions already entered in your Account Register to the Payment 
Calendar, as described below.
To add an existing transaction to the Payment Calendar:
1 In the Account Register, right-click the transaction you want to schedule.
2 Click Add To Payment Calendar, and follow the instructions on your screen.

Once you have added bills to the Payment Calendar, you enter them into your 
Account Register by checking them on the Payment Calendar list, then clicking the 
Enter button.
Follow the instructions on the next few pages to set up a complete bill-paying process using 
the Payment Calendar.



TIP:If you use Online Bill Payment with the Payment Calendar.



Setting Up a Bill-Paying Routine
Paying bills at regular times has its benefits—you can probably spend less time 
at the task overall, and if you have an interest-bearing checking account, you 
can get the most out of your money by paying bills closer to their due dates.
The procedure below offers one approach to streamlining your bill-paying process. If all of your 
regular bills are in the Payment Calendar, it’s easy to just sit down one or two times a month 
and take care of them.
To set up a bill-paying routine:
1 If you’ve been entering your bills in Money for a month or two, comb through the Account 

Register for your recurring bills. Add them to the Payment Calendar by right-clicking each 
transaction, then clicking Add To Payment Calendar.
If you’ve just started using Money, gather a couple months’ worth of bills so that you have a 
sample of each of your regular bills, and enter them in the Payment Calendar according to 
the steps on the previous page.
Be sure to choose an accurate frequency for each bill or deposit.
TIP: Record your deposits regularly.

2 Once you’ve entered your recurring transactions, click through a couple months of the 
calendar to see when most of your bills are due. 
Click the forward (right) arrow on the calendar to move ahead one month.

3 Set aside one or two days a month for bill paying, based on when your bills are due. 
For example, you might decide to have bill-paying sessions around the 20th (for bills due at 
the beginning of the next month) and the 8th (for bills due around the 15th). You can pay 
your bills farther in advance, but you might not have them all in hand yet.

When you sit down to pay the bills, simply go to the Payment Calendar, check off the bills that 
have arrived, and enter them in the Account Register, as shown in Determining Which Bills to 
Pay Right Now.
Going on vacation? If you use Online Bill Payment, you can use the Payment Calendar to 
schedule your bills up to two months in advance. Because payments are mailed according to 
their due dates, you can take care of all your bills at once without depleting your bank account.



Paying the Bills: Determining 
Which Bills to Pay Right Now
In a perfect world, we’d all have enough money to cover our bills as soon as 
they arrive. (Okay, in a perfect world, there wouldn’t be any bills at all.) But in 
reality, most people have times when their pile of bills is a little taller than their
stack of coins. 
As you pay the bills, the New Balance column in the Payment Calendar can help you decide 
which bills get taken care of right away, and which ones can wait until the checking account 
gets its next injection of funds. In addition, you can use the Balance Forecast chart to view 
future balances based on the transactions you have scheduled.
Money’s balance projections will be most accurate if your current balance is accurate, so you 
might want to make sure any outstanding transactions are entered in the Account Register 
before you start the following steps.
TIP:It  ’  s a good practice.  
To pay the bills:
1 Gather all the bills that need to be paid and add them to the Payment Calendar if you 

haven’t already.
2 In the Payment Calendar, click the checkbox of each bill you plan to pay.

You can check off a group of bills by right-clicking a date on the calendar. 
3 Modify specific payments as necessary by highlighting the transaction then clicking the Edit 

button.
4 Look at the New Balance column. Is the balance sufficient? If so, go to step 6.
5 You can see how paying—or not paying—different bills will affect your balance by clicking 

the checkbox next to each payment. Experiment with checking and unchecking transactions
until you’ve found the combination of bills that you can pay comfortably, without worrying 
about bouncing checks or paying bank fees.

6 Click the Enter button to enter the payments into the Account Register. 
7 Pay the bills. Either write, print out, or send electronically the checks for the bills you’ve just 

entered.



TIP:Those bill-paying blues.



Modifying Payment Calendar Transactions
Just because transactions are entered into the Payment Calendar one way does 
not mean they have to stay that way forever. You can modify any part of a 
Payment Calendar transaction at any time.

Use these buttons to add, change, or remove transactions from the Payment Calendar. You can also 
use commands from the right-click menus, as described in the procedures on this page.

To modify a transaction in the Payment Calendar:
1 Double-click the transaction in the list.

Money displays a transaction form. 
2 Make the necessary changes, then click OK.
When you change a Recurring Payment, Money updates the subsequent occurences of that 
transaction to reflect your changes.
TIP:If you use Online Bill Payment and have recurring payments.
To delete a scheduled transaction in the Payment Calendar:
1 Right-click the payment you want to delete.
2 Click Delete All Instances to remove the transaction from the Payment Calendar completely, 

or Just This Instance to remove the payment you clicked, but leave remaining instances as 
scheduled.



Balancing Your Account
The Balancing Act: 
Reconciling an account
Balancing—or reconciling—an account is really just a way to make sure that 
your numbers agree with the bank’s. Balancing helps you catch bank errors or 
find transactions that slipped through the cracks.
Money simplifies balancing an account by guiding you every step of the way. And when you 
track your finances in Money, you don’t have to worry about little math errors tripping you up
—so balancing can take just a few minutes.
In order to balance an account, you must have a bank statement. Otherwise, you won’t have 
an official number to balance the account against. Also, be sure to balance against your 
statements in the order in which you receive them. 
To balance your account:
1 Gather your materials:

If you use Online Banking, download your statement and enter transactions at 
least up to the ending date of the paper statement.

If you like to track details carefully to make sure the bank statement is accurate, 
track down your cleared checks, ATM receipts, and deposit slips for the month.

If you prefer to go by the bank statement and don’t want to cross-check, all you 
need is the statement.

TIP: Keeping the bank  ’  s records of your checks.  
2 Go to the Account Register and switch to the account you want to balance, then click the 

Balance button.



            

If the starting balance on the screen does not match the starting balance on 
your statement, there might be a previous statement you need to balance first.

3 Fill in the Balance dialog box using the numbers from your statement, then click the Next 
button.
If you downloaded your statement, interest and fees will have been entered already; you do 
not need to type them here.

4 Follow the instructions that appear at the right of your screen. If you see discrepancies 
between what you’ve entered in the Account Register and what’s on the bank statement, 
refer to your saved checks, deposit slips, and receipts.

5 If transactions appear on your statement but aren’t in the register, click the checkbox at the 
right of the screen to enter them.

6 When the difference between your cleared register balance and the ending balance on your 
bank statement is zero, your account is balanced. Click the Next button.

If your account doesn’t balance the first time through, AutoReconcile can help you find the 
problem. To use AutoReconcile, click the Next button in the Balance Account area, then click 
Next to have AutoReconcile look for possible errors.



Is Your Account Off Balance?
If you’ve tried AutoReconcile and your account still doesn’t quite add up, you can probably 
track down the problem yourself. Check the following:
Is there a transaction on your statement that didn’t get entered into Money? 
If so, click the “Click here to add or edit transactions” checkbox, then enter the transaction as 
usual.
Is there a transaction marked as cleared that doesn’t appear on your statement?
Make sure you didn’t inadvertently mark a check as cleared that isn’t listed on your paper 
statement. Click the C field again to remove the C.
Do all cleared amounts match the statement amounts exactly?
AutoReconcile might not catch transposed numbers if they’re combined with other problems. 
Check each number carefully against the statement.
Does the ending balance on your statement match what you entered in Money?
Double check the amount listed for “Statement” on the Money screen with the ending balance 
on your statement. To change the amount, click Postpone, then click Balance again to get back
to the start of the balancing process. Correct the number listed for Ending balance.
Did you enter all service charges and interest? 
Some bank statements are clearer than others when it comes to listing charges. If you do find 
additional charges, adjust the transaction in your register to reflect the total amount of the 
charges. 
Are all deposits and checks in the right columns?
Maybe the amounts are correct, but a deposit was entered as a withdrawal, or vice versa. Make
sure all transactions are listed in the appropriate column.



Using Wizards to Plan Your Savings
A penny saved is a 
penny earned: Saving
There are a lot more things to spend our pennies on today than 
there were in Ben Franklin’s time, but there are also more ways 
to save them. Money’s tools for saving include wizards to help 
you create a savings plan as well as charts and reports to help 
you monitor your progress.

Money provides two wizards to help you with saving: the Savings Calculator and the 
Retirement Planner. To use a wizard, go to the Planning Wizards area.
The Savings Calculator    The Savings Calculator provides a fun way to play “what-if” when 
you’re setting savings goals. Use it to answer questions such as:

How soon will I be able to take my $8,000 trip if I set aside $400 each month and 
get a 7% annual return?

Given my current savings, what return on my investments must I earn to save 
$100,000 by the year 2010?

How much will my $20,000 in savings grow in the next ten years?



The Savings Calculator fills in the answer you’re interested in based on the information you 
enter in the other fields. For example, to see how much you should save each month to reach 
your goal, leave the Regular Contribution Amount box blank, but fill in the rest of the boxes. Or 
if you know how much you can contribute regularly and want to know how it will add up, fill in 
all of the boxes except Savings Goal Amount, and then click Calculate to have Money fill in the 
blank box.
The Retirement Planner    The Retirement Planner walks you through a series of questions to
help you estimate how much you need to save each month to reach your retirement goals.

You can also use the Retirement Planner for other goals. To use it as a college planner, just use 
the Current Age, Retirement Age, and Life Expectancy fields to enter the student’s current age,
age when starting college, and age at graduation. Then go through the rest of the wizard, 
providing information about your college savings.



Save Twice With a 
Tax-Deferred Retirement Plan
The money you put into a tax-deferred retirement plan, such as an IRA, a 401(k), or a 403(b), 
works for you in two ways: It saves you money on your tax bill now, and it goes to work, 
growing tax-deferred, until you retire.
For example, a person earning $50,000 who put $5,000 into a tax-deferred plan would save 
$1,400 in taxes in a single year. The $5,000 investment, earning 8%, would more than double
—to $10,794, with no taxes on the earnings—after 10 years (in addition to the $14,000 saved 
in income taxes, assuming the same income and same tax rates).
If a tax-deferred retirement plan is available to you, the experts agree that your best move is 
to salt away as much money as you can, as early as you can. Use the Planning Wizards to help 
you determine what you can save. For more information on putting away money earlier rather 
than later, see The Magic of Compound Interest.



How Much Do You Need for Retirement?
It’s impossible to know exactly, but most people can assume they will spend less in retirement 
than during their working years. The general rule of thumb is that when you retire, you’ll need 
about 70% to 80% of what you’re spending before you retire. So if you’re spending $50,000 a 
year now, you’ll need about $50,000 x .75, or $37,500, per year for each year of your 
retirement.
Note: The Retirement Planner takes inflation into account and adjusts the figures accordingly.



Watching Your Savings Grow
Savings accounts, money-market accounts, and CDs (certificates of deposit) are
just a few of the instruments you can use to stash your cash. With Money, you 
can create a single snapshot of all these savings vehicles. 
The following procedure shows you how to set up a chart or report that you can use to monitor 
your savings at a glance, even if the money is spread among different accounts.
To create a savings chart or report:
1 In the Report and Chart Gallery, click the What I Have button.
2 Double-click Account Balances. Money displays a report or chart.

A chart provides a strong visual presentation; reports are good for looking at exact numbers 
and totals. Click the Report or Chart button at the bottom of the screen to switch between 
the two.

3 Click the Customize button. If you’re creating a chart, click the More Options button in the 
Customize Chart dialog box.

4 In the Include area, choose all of the accounts in which you keep your savings. 

5 Click the View button to see the report or chart that contains the balances of all your savings
accounts.

6 If you are satisfied with what you’ve created, click the Add To Favorites button and name the
report or chart. If you want to adjust an element, click Customize again and change settings 
until you have what you want.

When you add a report or chart to your favorites list, Money saves the settings so that you can 
look at the customized version whenever you want. Just click the My Favorites button in the 
Report and Chart Gallery to see a list of your saved reports and charts.
TIP:Nine ways to boost your savings.



Working With Investments

A penny saved is a nickel earned: 
Investing 
From the safest investments where you’re sure of your return (such as a CD), to
the higher-risk ones (such as a new stock with the potential for explosive 
growth), Money is well suited to tracking the investments you use to build your 
nest egg.
Before you use Money’s Investment Portfolio, it’s important to understand the difference 
between Investment Accounts and investments in Money. As with your own financial portfolio, 
you may have several different investments within a single investment account.
Investment Accounts provide a place to store individual investments. You might have a 
single Investment Account that contains all of your investments, or several Investment 
Accounts, one for each bank or brokerage house where you invest. 
Investments include stocks, mutual funds, bonds, money-market funds, and CDs and are 
added to Investment Accounts. You can have multiple investments in one Investment Account, 
just as you might hold a variety of investments through a single brokerage firm. 
You can set up your porftolio in Money in three simple steps: First, set up your Investment 
Accounts. (If you’re not sure which accounts to set up, see Determining Which Accounts to Set 
Up.) Second, add individual investments to those accounts. Third, update the prices of your 
investments to accurately reflect your portfolio’s worth.



Step 1: Entering Your Current Portfolio
Money makes it easy to keep track 
of your investments. You’ll use the 
Investment Portfolio to see the big
picture, including your portfolio’s 
total value and its distribution by 
investment type. And you can 
always click the Details button to 
see the specifics on any 
Investment or Investment Account.
To create your Investment 
Accounts:
1 If you aren’t sure about which accounts to set up, use the information in Determining Which 

Accounts to Set Up. to help you decide.
2 To set up an Investment Account that corresponds to a brokerage or institutional account, 

gather the most recent statements for the accounts as well as the purchase information for 
each investment (for example, the purchase price, number of shares, and commission for a 
stock purchase).

3 Go to the Investment Portfolio. 
4 For each account you want to 

set up, click the New button, 
choose A New Investment 
Account, and click Next. 
The New Account Wizard will 
walk you through the steps to 
set up the account. When 
you’re done, you’ll see your 
accounts listed in the 
Investment Portfolio.
Once you’ve created your 
Investment Accounts, you’re 
ready for the next step: 
entering your investments. 

TIP: Setting up a pool of cash 
for investing.

Step 2: Adding Investments to Your Portfolio
For an Investment Account you’ve just set up in Money, you’ll add investments 
you currently hold by recording investment activity in the account. If you want 
to detail your investment history, you might also decide to enter transactions 
for investments you’ve held in the past. 



To add investments you own to Investment Accounts:
1 In the Investment Portfolio, double-click the Investment Account to which you want to add 

an investment, or select the Investment Account and click the Go To Account button. This 
takes you to the Account Register for the selected account.

2 Click the New button in the transaction form, then type the name of the investment in the 
Investment field.
If this is the first time you’ve entered a particular investment, Money asks you to provide 
additional information about it.

3 Enter the purchase of the investment in either of two ways:
For an investment for which you know the purchase price, enter Buy in the Activity 
field, then type the quantity of shares and their purchase price. By default, Money transfers 
the funds to purchase the investment from the Associated Cash Account.
For an investment for which you don’t know the purchase price, for example, a stock
that you inherited, enter Add Shares in the Activity field, then type the quantity of shares 
you own. 
For an investment for which you have several purchase prices, for example, if you 
bought shares of a mutual fund at different times, you can enter every purchase individually
or just add the current number of shares as a group. To record each purchase, enter Buy in 
the Activity field for each transaction; to add the shares as a group, enter Add Shares in the 
Activity field and type your total number of shares.

4 To view your investments after you’ve added them, go to the Investment Portfolio. 
Whenever you purchase or sell an investment or receive interest or dividends, you’ll follow the 
basic steps listed above to record the activity in the appropriate Investment Account. In 
addition to Add Shares and Buy, the drop-down list in the Activity field has options specific to 
interest, dividends, capital-gains distribution, and so on. 
When you’ve finished adding all of your investments, you have an accurate picture of your 
holdings but probably not of their current value. As a final step, update the prices of your 
investments following the steps on the next page.
TIP:To track investments you don  ’  t own.  



Step 3: Updating Your Investment Prices
Updating your investment prices regularly helps you make decisions about your
investments. Money uses the most recent prices you entered to calculate the 
market value of each investment and Investment Account.
Updating prices is important for tracking the value and performance of your investments and 
for calculating an accurate net worth. You get the most revealing picture of an investment’s 
performance if you update your prices regularly.
TIP:Updating prices electronically.
If you buy more shares of an investment, create a Buy or Add Shares transaction 
following the steps on the previous page.
To update the prices of your investments:
1 Gather the latest prices for your investments.
2 Go to the Investment Portfolio.
3 Click the Update Price button.

4 Enter the current price of the stock in the 
Price field, then click the Update button. 
To switch to another investment, choose it 
from the drop-down list. 
It’s easy to create a price history for an 
investment. Just change the date in the 
Update Price dialog box to reflect the correct
date for each price you enter.

Getting Around Your Portfolio
Once you have your portfolio set up, Money provides a variety of ways to look 
at it. Take a minute to familiarize yourself with the different Investment areas.



Investment Portfolio    Use this area to view all of your investments at a glance. The triangle 
menu lets you organize and view your investments according to account or investment. You 
can also right-click any investment or Investment Account to view its Details or to enter 
transactions for it. 

Investment Details area    Use this area to view an investment’s price, transaction history, 
and other information. To get to Investment Details, right-click the investment, then click 
Details. To switch to another investment, click the triangle next to the investment name in the 
navigation bar.



Account Registers    Use this area to enter and view buy/sell transactions in an Investment 
Account. To get to the Account Register, right-click the account in the Investment Portfolio, 
then click Go to Account. To switch to another account, click the triangle next to the account 
name in the navigation bar.



Tracking Your Investments: Using Charts
Money’s reports and charts help you make informed decisions about your 
investments. And they’re fun, too. After all, one of the most rewarding things 
about investing money is watching your investments grow.
The charts below are examples of the Investment charts you can create by clicking the 
Investments button in the Report and Chart Gallery. You can customize any of these charts to 
show the exact information you want to see.

Portfolio Value By Investment Type    Use this chart to check the diversification of your 
portfolio: how much you have in stocks, how much in cash accounts, and so on. When the 
investment guru on the radio talks about being invested “80% in the market, 20% cash,” you’ll 
be able to see how your holdings compare.

Performance By Investment Account    Use this chart when you want to see how one 
account is faring compared to another, or even engage in a little friendly competition with your
spouse to see whose stock picks are doing better (provided you set up separate accounts in 
Money).



Price History    Look at each (or a select group) of your investments and see how their values 
have changed from the time you purchased them. This chart can help you tell at a glance 
which of your investments are doing well and which are languishing.
TIP:Inform yourself!



Determining Which Accounts to Set Up
When you’re deciding what Investment Accounts to set up, use the “one 
statement/one account” rule. That is, set up one Investment Account for each 
institutional account for which you receive a statement. There are a couple of 
exceptions to this rule.
For the following types of investment accounts, it’s a good practice to set up separate 
accounts: 
401(k)s and other retirement plans    If you want to use Money to help you prepare your 
taxes, you should set up a separate, tax-deferred Retirement Account in Money for each 
retirement account you have. See Setting Up a Retirement Account for more information on 
using a Money Retirement Account.
Investments you hold individually    It will be easiest if you set up one additional 
Investment Account—perhaps named Miscellaneous Investments—to keep track of 
investments you hold personally, such as savings bonds, mutual funds, or stock certificates 
that aren’t held through a broker.
Here are a few examples to help you decide which Investment Accounts to set up for your 
portfolio:

If your portfolio contains . . . You should set up . . .
Several mutual funds in a single 
account

One Investment Account

Several mutual funds in a single 
retirement account, such as a 401(k)

One Retirement Account

A money market fund and several 
stocks through the same broker

One Investment Account

An IRA or Canadian RRSP, several 
stocks, and a municipal bond through a
single broker

One Retirement Account for the IRA
or RRSP, and one Investment 
Account for all other investments 
with that broker

Three CDs at a bank, and a tax-free 
bond invested in through a broker

Two Investment Accounts: One for 
the bank and one for the brokerage
account

Several stocks, bonds, CDs, and mutual
funds through four different brokers or 
banks

Four Investment Accounts: One for 
each broker or bank

Setting Up a Retirement Account
If you keep your retirement investments in an IRA, SEP-IRA, 401(k), 403(b), 
Keogh, or Canadian RRSP account, set up a Retirement Account. Money makes 
it easy to update your retirement holdings and to track your contributions and 
those of your employer.
If you’ve used the Paycheck Wizard, you might already have set up a Retirement Account. For 
information on the Paycheck Wizard, see Entering Your Paycheck. To see whether you already 
have a Retirement Account set up, go to the Account Manager.
When you create a Retirement Account, Money automatically creates two accounts: one for the
cash you contribute to the account, and one for the investments you purchase with those 



contributions. When you purchase investments, you transfer funds from the Contributions 
account to the main Retirement Account.
To set up a retirement account:
1 From the Account Manager or Investment Portfolio, create a new account.
2 Choose Retirement as the account type, then follow the instructions on your screen.
3 When you’ve finished creating the account, update its investments so that it reflects the 

balance on your statement. The way you update your investments depends on the type of 
Retirement Account you have:
If you have an IRA or SEP-IRA, your statements probably detail your investment purchases. If
this is the case, enter the purchases according to the procedure in Adding Investments to 
Your Portfolio.
If you have a 401(k) or 403(b), the exact details of each investment purchase might not be 
listed on your statements. If this is the case, follow the procedure below.

To update 401(k), 403(b), and similar accounts:
1 Go to the Account Register for the Retirement Account.
2 Click the Update Account button on the right side of the screen.
3 Follow the instructions on your screen to update each investment in the account.
TIP:The magic of compound interest.



Working With Loan Accounts
Either a borrower or a lender be: 
Managing Loans
If you have outstanding car, house, line of credit, or other large 
loans (either that you owe or that are owed to you) the only 
way to get an accurate look at your net worth is by creating 
Loan Accounts to reflect debt. Loan Accounts also give you the 
pleasure of watching your loan principal dwindle with each 
monthly payment.

Once you’ve set up a loan, Money automatically calculates the principal and interest of each 
payment and keeps track of the balance due. You can create special reports to see a loan’s 
payment schedule, and you can include loan payments and balances in other reports and 
charts.
To work with Loan Accounts:
1 Gather your original loan documents or most recent loan statement, if you have one. You 

need the loan amount, interest rate, number of payments, and other information to set up 
the Loan Account.

2 In the Account Manager, click New Account and set up a separate Loan Account for each 
loan.
Creating a Loan Account in Money is much like creating any other account. Money walks you
through each step. 

As part of creating the loan, you can tell Money to remind you when payments are due, and 
specify which account the payments will come from. You’ll then be reminded each time a 
payment is due, and the loan transactions will automatically be recorded in both Money 
accounts.
If you use Online Bill Payment, you can make your loan payments electronically. If you told 
Money to remind you when the payments are due, the Recurring Payment will already be 
entered in the Payment Calendar. Simply highlight the payment, then click Edit to change it to 
an Electronic Payment (Epay) or Automatic Payment (Apay).
For more information about using the Payment Calendar, see Managing Recurring Transactions 
with the Payment Calendar. For more information about Electronic and Automatic Payments, 
see Paying Bills Online.
To read about making extra payments on your loan principal, search for “extra loan payments” 
in the online Help Index.



Wizards for Planning Loans
To explore your options for borrowing money, or to develop a plan to pay a loan 
off early, use the Loan Calculator. If you’re shopping for a mortgage, the 
Mortgage Planner can help you evaluate your options.
To use a Wizard, go to the Planning Wizards area.
The Loan Calculator    is a handy tool for comparing interest rates, loan amounts, and balloon
payments. Use it to experiment with “what-if” situations for different loans, such as:

How soon can I pay off my car loan if I pay an extra $50 a month?

How much more can I afford to borrow if I can find a loan that saves me a quarter 
point in interest?

If I can pay my loan off early, how much interest will I save?

The Loan Calculator fills in the answer you’re interested in based on the information you enter 
in the other fields. For example, to see how much you would need to shell out each month to 
pay off your car loan in two years, leave the Payment Amount box blank, but fill in the rest of 
the boxes. 
The Mortgage Planner is designed to compare two different mortgage loans with the same 



total amount. Use it when you’re deciding between two loans or trying to determine whether 
you can come out ahead by refinancing your current loan.
TIP:Refinancing a mortgage.



When Should You Pay a Loan Off Early
Paying loans off early is often an enticing prospect if you can manage it. But from a purely 
financial standpoint, you might be surprised to find that paying off a loan isn’t always the best 
decision. 
As a general guideline, you come out ahead paying a loan off early if the interest rate on the 
loan is higher than you could get by investing the same money. If the loan rate is particularly 
low, your money might work better for you in a good investment than in prepaying the loan.
However, if you just hate debt, the emotional advantage of being free of the loan could offset 
any financial gain you might reap from continuing to carry it. 



Setting Up a Budget 
Based on Your Spending History

Finding your limits: 
Budgeting
Money can’t supply the discipline to keep you from indulging in every spending 
impulse, but once you see the overall picture of your spending habits, you 
might discover restraint you didn’t know you had. 
A budget can be an important tool for bringing your expenses in line with your income and for 
planning for important goals. You might find that after sticking to a budget for a while, your 
spending habits become automatic and you don’t need to check up on yourself as often. 
Money makes it easy to set up a budget based on what you’ve earned and spent over a 
specific period of time, for example, over the previous 12 months or the last calendar year. 
Using automatic budgeting by itself is especially useful if you:

Already have at least six weeks’ worth of information entered in Money and have 
been categorizing your spending.

Are satisfied with what you’ve been doing and want to keep doing it.

Want to take advantage of an increase in income by saving more, and don’t want 
your spending to expand and swallow the extra money.

Have noticed a change in your spending habits that you don’t like and want to 
create a budget based on a period you were pleased with. 
To set up a budget quickly:
1 Click Budget on the Tools menu.
2 In the Budget dialog box, click the AutoBudget button.



3 In the AutoBudget dialog box, 
specify the period you want to base
your budget on, and then click the 
Create button.

4 In the Budget dialog box, adjust the
amounts for specific categories as 
needed.

Because AutoBudget sets amounts 
based on a category’s average over 
time, large, unusual earnings or 
expenses can skew the budgeted 
amount. For example, if you add a 
new roof to your 
house one year, you probably don’t want to continue to average its cost into your monthly 
budget for Home Repair. Or if you have a windfall such as an inheritance, you don’t want to 
rely on that income month after month.



Creating a Budget to Meet Your Goals
If you’re creating a budget because you want to change your spending habits or
meet a specific goal, you’ll want to put a little more thought into your budgeted
numbers. The more care you put into creating the budget, the better the 
chances that you’ll create one that’s going to work for you.
The automatic budget figures based on your spending history (described on the previous page)
are a good place to start in creating a budget to change your spending, but you’ll want to use 
other Money tools to help you figure out where you want to make changes.
TIP:If other people will be affected by the budget.
To create a budget that will help you meet your goals:
1 If you have at least six weeks’ worth of categorized information entered, create an 

automatic budget as a baseline. (Follow steps 1–3 in Setting Up a Budget Based on Your 
Spending to create an automatic budget.)

2 In the Report and Chart gallery, click Spending Habits, then go to the Monthly Cash Flow 
report.

3 Click the Customize button and choose Last 12 Months as the date range, then print the 
chart. (You’ll probably want to mark it up.)

4 Use the Monthly Cash Flow report to determine your net spendable income. 
Your net spendable income is all of the income you can count on receiving (such as salary, 
dividend income, or rental payments) minus unavoidable fixed expenses (such as a 
mortgage payment, medical expenses, or child support). 
The figure you come up with for your net spendable income is the figure you can distribute 
among all the remaining spending categories for your budget. Follow the steps on the next 
page to finish creating a budget based on this figure.

5 Come up with some rough numbers for spending categories based on your net spendable 
income.
You can open the Windows Calculator from Money’s Tools menu. The Calculator might come 
in handy as you work on your budget.

6 If you created an automatic budget, print the My Budget report and compare your estimates
for each category to the numbers that appear on your budget.
Expect the numbers to differ—after all, you’re trying to change your habits. But look for 
categories where the proposed numbers and the numbers based on your previous spending 
differ dramatically. In these categories, you might want to consider whether you can really 
adjust your spending that much, or whether you might want to adjust your proposed budget.



7 Once you have numbers you think you can live by, plug the new numbers into the budget 
for each category. Choose Budget from the Tools menu, and then highlight a category and 
enter the budgeted amount. 
For the most realistic budget, enter items that don’t occur every month as lump sums in the 
appropriate month. For example, if you pay your car insurance every six months, add the 
premiums only to the months they are due, rather than averaging them out over the year. 

8 Create a My Budget report and post it where you can see it.
TIP:If you  ’  re budgeting toward a goal.  



Checking Up on Your Budget
Money makes it easy to follow your progress when you’re trying to stick to a 
budget. You can update your budget as your needs and goals change.
The How I’m Doing On My Budget chart compares the numbers you’ve budgeted in each 
category (or categories you select using the Customize button) to the “real” numbers of what 
you’ve spent. You can use this chart as a check-up, as well as to see if there are any regular, 
large discrepancies between the money you’ve allotted and the money you’ve actually used. 

Consider changing your budget for a category in which there’s a consistent, dramatic 
difference between the budget and reality.
If you do find chronic differences between your budgeted figures and the real ones, there’s no 
rule that says the budget, once set, is set in stone. You might want to reduce the budget for a 
category if you’re constantly coming in below the budgeted figure, or find the resources to add
a little more to an area in which you’re always over budget. Remember that the budget is there
to serve you and your goals. If you want to stick to a budget, it’s important to create a 
reasonable one; otherwise, the frustration of always seeing the Actual amount higher than the 
Budget amount might just make you throw in the towel.
TIP:Questions to ask yourself when you  ’  re tempted to make a questionable purchase.  



Working With Credit Card Accounts
Pay credit when credit is due
If you want to categorize your credit card charges, download 
your credit card transactions using Online Banking, or tend to 
maintain a running balance on your credit card bill, it’s probably
a good idea to set up a Credit Card Account.
On the other hand, if you want to track only a few major purchases, and if 
you generally pay your account in full every month, you can just enter a 
single payment

from your savings or checking account and not set up a separate Credit Card Account. For the 
purchases you want to track, use split transactions; for other purchases, just use the Credit 
Card category.
Whether or not you use a separate Credit Card Account, you can categorize or classify each 
charge on your account so that your budget and tax records are complete. And you can use 
the Payment Calendar to make sure the bill gets paid on time, so that you avoid the finance 
charges levied with late payments.
Note If the credit account you’re working with is a bank line of credit rather than a credit-card 
account, choose Line of Credit as the account type.
If you opt to track your credit card spending with Money’s Credit Card Accounts, follow these 
steps:
To work with Credit Card Accounts:
1 Set up a Credit Card Account for each credit card or charge account.

Creating a Credit Card Account in Money is much like creating any other account. In the 
Account Manager, Money walks you through the steps to create the account. If you maintain
a running balance, be sure to have your most recent statement available when you create 
the account so that you can enter an accurate balance.

2 When you make a purchase, enter it directly in the appropriate Credit Card Account. (Or 
enter all purchases when your statement arrives.)

3 When you make a payment on the credit card, enter the payment as a transfer from the 
account you pay from to the Credit Card Account.

TIP:If you use Online Banking and have a credit card.



Is Credit Costing You Too Much?
Between annual fees and high percentage rates, your credit-card purchases could easily end 
up costing you an additional 10-15 percent (sometimes even more!) of the purchase price. To 
see whether you’re paying too much for the convenience of plastic, ask yourself the following 
questions:

Do you pay only the minimum balance on your credit cards, even if you can afford 
to pay more?

Do you have a card with an annual fee?

Do you have more than one credit card with a balance you carry from month to 
month? 

Do you regularly pay finance charges for missing or late payments?

Do you purchase things on credit that you know you can’t pay for over a few 
months?

Do you owe over 20 percent of your yearly after-tax income? (Don’t include your 
home mortgage.)
If you answered yes to any of the above questions, you might be surprised to know how much 
money your credit-card company is making on your habits.



For example, with the interest rate on the average card around 18%, paying the minimum 
balance for a $1,200 big-screen TV would take 12 years and nine months to repay, and by then
you’d pay an additional $1,673 in interest. 
Fully 70% of U.S. cardholders carry a balance from month to month. Carrying a balance 
occasionally is OK; in fact, it can get you through a tough time or allow you to purchase 
something you need that you couldn’t otherwise afford. But remember that you pay a price, 
and usually a pretty big one, for the privilege of buying something big for only a few dollars a 
month.



Guidelines for Handling Credit Cards
If you feel like your credit cards are an expensive habit, try the following guidelines: 

As a general rule, pay off your cards every month unless you’re confronted with a 
real emergency.

If you can’t pay the card off completely, pay as much as you can afford each 
month. Paying just $10 over the minimum due each month on a $3,300 credit-card debt will pay 
the debt in 4 years instead of nearly 19 and save almost $2,800 in interest.

If you already have a lot of card debt, consider consolidating your cards under a 
low-interest-rate bank loan, or shopping for a better deal. Then spend a year or so paying off old 
debts without adding new ones.

If your credit card has an annual fee, ask the company to drop it. Many companies
will cancel their fees rather than lose you as a customer.



Encouraging Good Habits
It’s time you learned the value of a dollar . . .
Kids and Money
Money is a tangible part of most children’s lives. With Money and some 
forethought, you can help foster the financial values you most want for the 
younger members of your household.
By the time your children can read, chances are they’ll be ready to start managing their own 
money. Many of the tools in Money can be used easily by children; the ideas below can help 
kids get excited about figuring out their finances:

Let your children create their own, separate Money file in which they can track 
their finances as soon as they get their own bank accounts. If a child can write legibly and has a 
source of income (such as an allowance) to put in the account, the child is old enough to open an 
account in their own name.

Let your kids create their own budgets and help them stick to them. You can go 
over the How I’m Doing On My Budget report together to review whether their allowance is 
appropriate or to troubleshoot why they keep running out of money before allowance day.

Kids can have a good time using the Savings Calculator to see how their allowance
can add up over the years or to plan how many lawns they have to mow to buy the latest cool 
pair of shoes.

If you have an investment targeted for an older child, such as a mutual fund 
earmarked for college, update its price regularly and show the child the chart. Let the child 
contribute to the fund if they want.



Older children might enjoy tracking the stock of a company that interests them 
(such as a favorite store or restaurant chain) and creating charts of the stock’s performance. 
They don’t have to own the stock to make it fun, but you might consider a gift of stock (many 
brokers will sell you a single share) to make it even more interesting.
TIP:If you use Online Banking for your accounts.
In addition to helping them learn about money by using Money, there are several other ways 
you can instill strong financial values in your children. 
Consider the following:

Taking young children shopping with you can provide an opportunity to show them
how you make buying decisions. The produce department is a great place to let them see how 
differences in quality affect your selection. For example, you might choose a smaller, firmer apple
over a larger one that has a bruise.

Distributing allowance money into separate jars can help children begin to 
visualize the ideas of different purposes for money. Create a jar for fun money, for longer-term 
goals, and maybe for savings and charitable donations. The fun-money jar can be raided at will. 
For inspiration for the long-term goals jar (the younger the child, the shorter the wait should be), 
tape a picture or description of what the money will ultimately be used for on the jar. 

As appropriate, involve your kids in the family financial picture. Set a fun financial 
goal together, such as a vacation. You might be able to enlist enthusiastic support for a budget 
when you can show the kids how it helps the family reach the goal. 

Take advantage of your position as role model. Your decision to not buy that nifty 
but unnecessary electronic gadget will make it easier for your child to bypass the latest fad toy in
favor of putting money toward a more important goal (such as a more expensive, higher quality 
fad toy).



TIP:Five thoughts about allowances.



Notes for Quicken Users
Welcome to Money: 
Notes for Quicken Users
Money provides a full-featured converter for your Quicken files. Just about 
everything in your existing Quicken file can be opened in a new Money file 
without a hitch, so that you can soon begin taking advantage of Money’s easy-
to-use interface and sophisticated features. 
Whether you have been using Quicken for DOS 5.0 or later, or Quicken for Windows, you can 
use Money to do the things you’re used to doing, only better. 
Of course, we recognize that this isn’t just a letter to your Aunt Sophie that you’re converting. 
These are your financial records, compiled perhaps over the course of years. The most 
important feature of the conversion process is that it keeps those records safe. Here are some 
other things you need to know about what’s happening:
Your Quicken file remains intact.
Money makes a copy of your Quicken file and converts the copy, not the original. So your 
original financial records remain untouched.
You can still use your Quicken file in Quicken.
Because Money converts a copy of your Quicken file, the original file is still available to use in 
Quicken. However, you can’t go back and forth between Quicken and Money in the same file.
You can convert individual accounts back into Quicken by exporting them from Money, then 
importing them in Quicken. For more information, look up Export in the online Help Index.
Money keeps you informed of everything that happens during the conversion.
When your file is completely converted, Money displays a summary screen so that you can see
your converted accounts and balances at a glance. If Money ran into any issues that needed to
be resolved during the conversion, those resolutions are listed as well.
TIP:To view a complete table of the conversion process.



Preparing Your Quicken File
Money will be able to open and convert every part of most Quicken files. 
However, if your file is very large or complex, you might want to go through the 
file in Quicken and refine a few things before you begin the conversion.
You don’t have to do anything to your Quicken file before importing it. However, if you want to 
be completely prepared, open your file in Quicken and go through the following steps.
To prepare a Quicken file for conversion to Money:
1 Determine whether all of your accounts can be imported. 

Money supports up to 63 of each of the three major types of account. If you have more than 
63 bank accounts, including checking, savings, and credit card, more than 63 Investment 
Accounts, or more than 63 Loan Accounts, Money converts the most recently used accounts 
of each type. If you have too many accounts, you can:
Make accounts inactive in Quicken  if you don’t want to use them in Money. This way, 
the accounts remain intact in your Quicken file but aren’t imported to Money.
Create two Money files    Review your accounts and decide which ones belong in the same
file. For example, accounts between which you transfer funds should stay together. If you 
choose this method, you will convert the Quicken file twice: once for the first set of 
accounts, and once for the second. When converting one set of accounts, make the other 
set inactive.

2 Review your Category list.
Money imports up to 250 categories and subcategories. If your Quicken file contains more 
than 250 when Money converts it, Money first converts the categories you use most. If the 
cutoff point is reached, only your unused and least-used categories are affected. If Money 
can’t convert a category, affected transactions are assigned the category “Deleted 
Category,” so you can find them easily.
If you use more than 250 categories, you might want to use Quicken’s search and replace 
feature to reassign transactions before the conversion.

3 Quicken 5.0 users only: If you have multiple budgets in Quicken, decide which one you’d 
like to use in Money.
Money supports only one budget, and will automatically convert the one you’ve used most 
recently. If you want to use a particular budget in Money, view it in Quicken before you 
convert.



Converting Your Quicken File
The conversion itself is as simple as opening your Quicken file in Money. The 
Converter Wizard for Quicken walks you through the process and keeps you 
informed as you go.
To Convert a Quicken file to Money:
1 If you like, prepare the file according to the steps in Preparing Your Quicken File.
2 Close Quicken and launch Money.
3 Click Open on the File menu.

You won’t need to choose Open if you haven’t yet worked on a Money file or if you’ve just 
been viewing the Product Tour—in these cases, Money will prompt you to open a file.

4 In the Open box, make sure you have Quicken Files selected in the Files of Type field. Go to 
the folder that contains your Quicken file, then choose it from the list (it will have the 
extension .qdb or .qdt). 

5 Money leads you through the Converter Wizard for Quicken. Follow the instructions on your 
screen until the conversion is complete.
When you’re finished, Money displays a summary of everything that happened during the 
conversion. 

6 Save the conversion summary as a text file so that you have a copy of it for reference.



After the Conversion
You did it! 
What’s next?

If you haven’t yet taken the tour designed especially for people who have used 
Quicken, now would be a good time. Click Product Tour on the Help menu to get started. 

Read carefully through the summary of your conversion, and make sure that:
Your account balances converted correctly    In the majority of cases, they will match 

perfectly. If they do not, the summary explains the reason for the difference. To adjust an 
account’s balance, see “adjusting” in Money’s online Help Index.

Your categories converted successfully    If your categories went over Money’s limit, 
Money assigned a single category to any transactions that lost their categorization. To search
for and recategorize these items, see “recategorizing” in the online Help Index.

Sign up for Online Services.
Money’s Online Services are similar to Quicken’s, but you do need to sign up for them 

separately. After you’ve converted your file, see Signing Up for Online Services to sign your 
accounts up for Online Bill Payment and Online Banking, or sign up for Online Quotes. 

When you’re ready to switch to Money’s Online Services, it’s a good idea to call your bank 
and let them know, just to ensure that you don’t get billed twice. Also, Money does not 
download transactions from Quicken’s IntelliCharge credit card—but you can keep using the 
card.

We’re glad you’ve chosen to give Money a try! We’re sure you’ll find it intuitive and easy to 
use. To help you get up to speed quickly, be sure to read the Tip of the Day each time you open
your Money file.



Eleven Things Every Quicken User 
Should Know About Money

1 By default, you enter transactions in Money on forms that look like checks and 
deposit slips. If you prefer to enter transactions directly into your register, you can 
do that too. Look up “Entering a transaction directly into the register” in online 
Help. 

2 Just like in Quicken, you can type + or – in a date or check number field to increase
or decrease the entry by 1.

3 In Money, a transfer is its own transaction type. To enter a transfer, you use a 
special transfer form. 

4 Money’s AutoComplete is similar to Quicken’s QuickFill; it helps you can minimize 
the time you spend typing transactions.

5 Money’s Tools/Find command is analogous to the Edit/Find command in Quicken. 
You can search for a transaction or group of transactions from anywhere in Money
—you don’t have to be in the Account Register.

6 Money’s calculator pops up any time you type an operator key (+, -, *, / ) in an 
amount field, just like Quicken’s. 

7 You can still use the printer checks you ordered to use with Quicken. On the File 
menu, point to Print Setup, then click Check Setup to choose your Quicken checks.

8 You can use the triangle menu at the top of the Account Register to go to a 
different account.

9 In Money, you can right-click any transaction or account name to see a menu of all 
the things you can do with it. 

10 Just about anything you need to do in a Money area is represented by a button in 
that area. You’ll find that you don’t need to use the menu bar at the top of the 
screen nearly as much as you did in Quicken.

11 In Money, you schedule recurring transactions in the Payment Calendar according 
to their actual due dates; you do not need to group recurring transactions, as you 
did in Quicken.

Accessibility for People With Disabilities
Microsoft is committed to making its products and services easier for everyone to use. Based 
on the combined input of users who have disabilities, organizations representing disabled 
individuals, workers in the rehabilitation field, and software developers who create products for
people with disabilities, Microsoft has designed several features for Windows 95 that make 
Microsoft Money more accessible for people with disabilities. These features include:

General accessibility features, such as the ability to quickly toggle accessibility 
features on and off.



Features for users with limited vision, including customizable mouse display and 
high-contrast color schemes.

Features for users who have difficulty using a keyboard or mouse.

Features for users who are hearing-impaired, including ShowSounds and 
SoundSentry, which provide visible feedback for audio cues.

Features supporting the use of alternate input devices, such as head-pointers or 
eye-gaze systems.
To use the accessibility options, choose Settings from the Start menu, then click Control Panel. 
If you installed accessibility options when you installed Windows 95, an Accessibility icon 
appears in the Control Panel. Double-click this icon to review the Accessibility features, and 
right-click on any option for a description of what it does.
Note: For more information on Microsoft products and services for people with disabilities, 
contact:

Microsoft Sales Information Center 
One Microsoft Way
Redmond, WA 98052-6393
Voice telephone: (800) 426-9400
Text telephone: (800) 892-5234
Fax: (206) 635-6100



Money saves your changes automatically as you work, so you don’t have to. 
However, you can create a backup copy of your file when you exit Money so 
there are two copies of your most recent work. 
If your main file becomes damaged or is lost and you want to use the backup 
file, open it by choosing Restore Backup from the File menu.
For more information on backing up and restoring files, click Help Topics on the 
Help menu and look up “backing up files” in the Help Index. 



If you used Quicken before, Money has online Help just for you. From Help’s 
Contents tab, choose Help for Quicken Users. 



If you can’t find the answer you need in this book or in Help and you have 
Internet access, try the MoneyZone for the fastest answers to your questions.
If you don’t find what you need on the MoneyZone and if Money came pre-
installed on your computer, contact the manufacturer. 
If you have problems using Money for electronic banking banking, call the 
number listed on the Contact Information tab in the Home Banking area. 
For more information on contacting the appropriate source for technical 
support, go to the online Help topic “Getting Help”/“When you need more 
assistance.”



If you track your home loan (or other large loan) in Money, net worth reports can 
be a bit unsettling—the average home loan these days adds a pretty big 
negative number to any report. To accurately reflect your net worth, set up a 
corresponding Asset Account for each Loan Account that covers a major 
purchase. This way, while you may owe a bunch of money on your home, the fact
that it’s worth even more will be reflected as well.
When you have an Asset Account for your home, you can also use the account to 
record the cost of any home improvements you make. Accurate home-
improvement records are important for taxes (improvements are generally 
deductible, and are subtracted from capital gains if you sell the home) and 
insurance planning.
When you set up an Asset Account for your home or other large purchase, use the 
purchase price as the opening balance. When you add improvements, create an 
Increase transaction indicating how much you spent.



Get immediate access to the accounts you work in most frequently. To add an 
account to the top of the Go To menu in the navigation bar, go to the Details 
area for the account. (From Account Manager, select the account and click the 
Account Details button.) In the Details window, choose Favorite Account.



You might prefer to press Enter, rather than Tab, to move between fields as you
enter transactions. To change this setting, click Options on the Tools menu, 
then click the Editing tab. 



Check out the options available for entering and editing transactions by 
choosing Options from the Tools menu, then clicking the Editing tab. 

Click the triangle to the left of the view bar to change what you see in the 
Account Register, Account Manager, Payees and Categories, and Payment Calendar.

For example, in the Account Register, you might prefer to enter transactions directly into 
the register, rather than on transaction forms. Click the triangle to the left of the view bar, then 
click Transaction Forms to deselect it. You can use the same procedure to turn the forms back on
—you’ll need to view forms to enter a transfer.

To switch between a detailed view of the register and top-line-only view, press 
Ctrl + T.

Money remembers the last five transactions you made to a certain payee. 
Once you’ve entered a payee name, right-click the Payee field and choose Previous Amounts 
from the menu. Click one of the listed payments to enter its information for the transaction. For 
example, say you normally enter your company name in the Payee field for your paycheck 
deposits, but once a year you deposit a bonus. The next time you enter your paycheck, you can 
get back to the memorized paycheck deposit by choosing it from the list.



If you use names that are similar, or if you’re used to referring to a payee by an 
abbreviated name, you might want to use abbreviations. Money replaces the abbreviation 
with the full name when you move to the next field. For more information, look up “abbreviations”
in the online Help Index.

If you use Online Bill Payment or printer checks and want to enter information 
for your own use that you don’t want to appear on the check, just enclose it in curly brackets—
{ }—in the Payee field.

For example, if both your mortgage and your car-payment checks go to the same bank, you 
can create two unique payees: Best Bank {house} and Best Bank {car loan}. 

Typing a plus sign (+) in the Number or Date fields advances the check 
number or date by 1, based on the last transaction you entered. Typing a minus sign (-) goes 
back a day or a check number.

Right-click the Date field to instantly enter yesterday, today, or tomorrow as 
the date.

The Calendar lets you quickly enter any date. Click the down arrow at the 
right edge of the Date field to display the calendar. Clicking a date enters it in the date field. To 
move ahead or back a month, click the arrows to the sides of the month name. To view the 
months of the year, click the year.

Money gives you instant access to a calculator from any amount field. To use
the calculator, just click the down arrow at the right edge of the amount field, or type a number 



and then an operator key (+, -, /, or *). As soon as you press Enter, the answer to your equation 
becomes the amount in the field. 



Money helps you enter a transaction as quickly as possible by remembering every transaction 
you make. As soon as you begin typing a payee name, Money looks for a payee that matches 
what you are typing. If there’s more than one match for the first couple of letters—if, for 
example, you have one previous transaction to Mary’s Mufflers and one to Martin’s Muffins—
just keep typing until you get to the letter that makes this payee unique.
Even better, once you tab out of the Payee field, Money’s AutoComplete+ fills in the rest of the
information for you, based on the last check you wrote to this payee. 
Once you’ve entered transactions for a month or two, just about all your regular transactions 
will be on Money’s memorized list. So entering a check or deposit can be as simple as typing a 
letter or two and pressing Tab.
You can change anything Money fills in for you. For example, your electric bill will probably 
vary from month to month, so you can update the exact amount each month.



To recategorize a group of transactions, just go to Payees and Categories and 
click Categories. Highlight the category you want to move transactions from, 
then click the Move button. In the Move Transactions dialog box, enter the 
category you now want to use. 



If you have a leftover amount you want to apportion between all the parts of a 
split transaction, press the F6 key. For example, if you’ve entered the purchase 
prices for several items and all that’s left over is the sales tax, pressing F6 will 
distribute the tax proportionally among the items. 



When you enter checks that you’re going to print, you don’t need to type a 
check number on the check form. Instead, just enter “Print” in the Number field
when you enter the check. When you print checks, Money asks you for the 
starting check number of the checks you put in your printer and assigns the 
correct check numbers from there.
Money will automatically print the payee's address on a check if you've entered
the address in the Payee Details area. 



Online Banking generally offers a free trial period, so you have nothing to lose 
by giving it a try. 
After the trial period, a monthly fee will be automatically deducted from one of 
the accounts you set up.



Signing up for and using Online Services should be pretty easy. But if you do encounter 
problems along the way, follow these steps until you find the answer you need:
1 Look up the problem in Money’s Online Help.

You’ll find solutions for many common problems in Help. From the Home Banking area, click 
the question mark in the navigation bar. Click the Index button to search for a particular 
term or topic.

2 Connect to The MoneyZone and look for answers
This web site contains answers to frequently asked questions about Money and is updated 
regularly. Search the Frequently Asked Questions area first—chances are that there will be a 
topic covering your question.

3 Ask a question 
If you don’t find the answer on the MoneyZone, you can go to the Microsoft forum on most 
online services (for example, MSN) to ask questions of Microsoft technical experts or other 
Money users. 
From The MoneyZone, you can jump straight to the Money Forum on MSN, where Money 
users share tips, tricks, and advice in the Money Chat area.

4 Call for help.
If you have set up Online Services, you can send an electronic letter to your bank using the 
Write Letter button on the Connect tab in the Home Banking area. Alternatively, you could 
call the customer-service phone number listed on the Contact Information tab. Call this 
number for technical support on Online Services. 
If you have not yet successfully set up Online Services, call your bank.



If you use Online Banking, you can send electronic letters to your bank. As with online 
payments, you create these letters before connecting to Online Services, then send them when
you connect. 
The Connect tab in the Home Banking area has a Write Letter button, which you can use to:

Ask about a specific payment.

Ask a general question about Online Services or your account.

Order new checks (depending on your bank).

Request copies of checks that have cleared (depending on your bank).
Generally, a person from Online Services will respond to your letter within two or three 
business days. You’ll receive the response when you connect to Online Services again.



Transaction records stay in the bank’s computer for up to two months, but the 
exact amount of time varies by bank. You should connect at least every other 
month in order to download all of your transactions. However, if you miss a 
couple of months, don’t worry. Your bank will still send paper statements you 
can use to get your accounts up to date.



No matter what changes you’re making to your Online Services, the basic steps are the same: 
You’ll go to the Home Banking area and click the Select Online Services button on the Accounts
tab. Here are some additional instructions for specific changes. If you:

Move to a different area of the country and need a new phone number to connect,
call your bank’s Customer Service number, listed on the Contact Information tab in the Home 
Banking area.

Switch banks but want to continue to use Online Services, add your new accounts 
to Money and go through the online setup process again. Your former bank should stop your 
Online Services automatically when you close your accounts. 

Want to add or cancel a specific Online Service, click the Select Online Services 
button. The setup wizard will give you the chance to enable or disable the service(s). If this 
doesn’t work, call your bank’s Customer Service number.



By default, Money lets you confirm every transaction on your electronic 
statement so that you can review them (and make changes) before they’re 
added to your register. 
If you prefer, you can skip the confirmation step. Click Options on the Tools 
menu, then click the Online Services tab. Clear the box marked “Ask me to 
confirm each match.”



If you use Online Bill Payment with the Payment Calendar, paying bills becomes
a simple matter of clicking to send payments when you’re reminded that 
they’re due. To read about Online Bill Payment, see Paying Bills Online.



Although it might not seem as critical to record your deposits as regularly as 
you record your bills, entering your regular deposits using the Payment 
Calendar can help you estimate what your account balance will look like a few 
months down the road.



Although recurring bills are the main focus of the Payment Calendar, it’s a good
practice to enter any recurring transaction. Deposits and transfers you make 
regularly are sure to get added to the Account Register if they’re scheduled in 
the Payment Calendar, and it’s easier to enter them as well!



Although Money can make it easier to pay your bills on time, even Money can’t give you more 
money. If you do get into the position of needing to choose which bills get paid right now and 
which don’t, consider these guidelines:

Pay bills that accumulate finance charges first.

Use the procedure outlined on these pages to see which bills are tipping your 
account balance out of your comfort zone. It may be that you can take care of a bunch of little 
bills, and a large one can wait. 
To help keep bill-paying time as pleasant as possible:

When you get bills, open them right away so you don’t sit down to big surprises 
later. If a bill seems astronomical, you can plan to review it while there’s still plenty of time before
the amount is due.

Establish a guideline for when you pay the bills. Maybe it is on a certain day every 
month. Maybe it is when you can’t shut the bill drawer. If you have some kind of trigger, it’s more
likely you’ll actually sit down and do it before things get overwhelming.

Keep your bills in one place. It’s less stressful to pay the bills if you don’t have to 
spend an hour rifling through house, car, briefcase, and coat pockets first. 

If you generally “do the bills” with someone else in your household, make an 
occasion of it. Buy ice cream. Pop popcorn.





If you use Online Bill Payment and you have Recurring Payments that are 
always for the same amount (such as a loan payment), the simplest approach 
is to use Automatic Payments (Apays).



Money’s Payment Reminder reminds you when bills are due, even if you don’t have Money 
open. The Payment Reminder icon appears on your Windows task bar whenever you are 
running Windows. The icon changes according to whether or not you have scheduled payments
due in your most recently opened Money file, as shown below.

No bills are due Bills are due Bills are past due
When you have bills due or past due, click the Payment Reminder icon to see a list of the bills. 
You can then launch Money right from the Payment Reminder.
The Payment Reminder reminds you of transactions scheduled in the Payment Calendar only 
(so if you post-date a check in theAccount Register, you won’t be reminded). 
By default, the Payment Reminder alerts you 10 days before a bill is due. To change that 
number, click Options on the Tools menu, then click the Payment Calendar tab. You can also 
turn the Payment Reminder off, using the Payment Reminder tab in the Options dialog box.



Keeping the bank’s records of your cleared checks is always a good practice. 
Canceled checks often serve as receipts for charitable donations, and they can 
prove useful in other situations to verify that a payment was received. If your 
bank sends you your canceled checks, you can store them easily in the same 
boxes you get when you receive new checks.



A Planning Wizard is a self-contained tool that leads you through a specific 
task; the work you do in Money’s Planning Wizards doesn’t affect any of your 
accounts.



1 Let the bank do it. Many banks will transfer a set amount from checking to savings each 
month.

2 Pay yourself first. Make saving an indispensable line item in your budget. Don’t save 
what’s left over after a month of expenses—save first, then spend only what you can afford.

3 Save by percentage. If your income varies from month to month, put away a fixed 
percentage of your income, rather than a set dollar amount. That way, you’re not extra 
strapped when a paycheck is small, and you get extra savings when you earn more.

4 Use the Threshold Method. When your checking account stays above a certain threshold 
(say, above and beyond your monthly expenses) for a certain period of time, put the extra 
money into savings.

5 Be patient. Once your savings reach a certain size (it’s different for everyone), it suddenly 
starts to feel like real money, and that makes it easier to save more.

6 Maintain proportions. It’s easier to increase your savings if you bump up your payroll 
contribution when you get a raise. 

7 Save your savings. When you save money by buying on sale or by resisting temptation 
completely, write your savings account a check.

8 Protect your savings account. Keep it out of reach of your ATM card.
9 Invest. Don’t keep more than a few months’ living expenses in a savings account—you 

might actually lose money once inflation is taken into account.



Investment Accounts differ from Asset Accounts in that Investment Accounts are tailored to 
tracking investments whose market value fluctuates frequently. Asset Accounts are better for 
keeping records for real estate, valuable collections, and personal property.
To read about working with Asset Accounts, see How Do I Know What Accounts to Set 
UpHow_Do_I_Know and Assess Your Assets and look up “Asset Accounts” in the online Help 
Index.



With a brokerage account, you typically have a money market fund or “cash 
manage-ment account” to use as a pool of cash for investing. When you buy or 
sell an invest-ment, cash is removed from or added to your cash balance.
The New Account Wizard asks if you want to set up such an account, called an 
Associated Cash Account, for each Investment Account you set up.



You can use Money to track investments that you follow but don’t own. Simply 
add the investment you want to track by clicking the New button in the 
Investment Portfolio. The investment will appear in the list (in Investments view
only) when you update prices, but won’t become a part of any of your 
Investment Accounts and won’t affect the value of your portfolio.



You can use Online Quotes to update the prices of your stocks and mutual funds with a single 
phone call. (The quotes are free of charge, as long as you have Internet access and a web 
browser compatible with Microsoft Internet Explorer.) Once the call is complete, Money updates
your Investment Portfolio and charts with the new values for each investment.
Electronic price updates let you spend your time studying the performance of your 
investments, rather than entering data.
Internet Quotes provide free stock-price updates as often as you like. When you use Internet 
Quotes, you also receive information about the stock’s previous-day close, trading range for 
the day, and number of shares traded.
To use Online Quotes, you need a modem and the ticker symbols for the investments you want
to update. (To add a ticker symbol to an investment, right-click the investment name in 
Investment Portfolio, then click Details.) Before you can use Online Quotes, you must go 
through the Online Quotes Setup wizard by clicking the Online Quotes Setup button in the 
Investment Portfolio.
If you don’t use a web browser, you can still update your stock prices electronically several 
times a month for a nominal fee.



The right-click menus in the Investment Portfolio are among the most robust 
you’ll see in Money. Right-click on the name of any investment or Investment 
Account to see a list of everything you can do.



The earlier you put it away, the more a set amount of money can work for you. For example, 
imagine two people: one starts saving toward retirement at age 22 and puts aside $50 a 
month at 10% interest for just eight years, and then lets the balance accrue interest until 
retirement. The other begins saving at age 30 and puts away $50 a month, also at 10%, for the
next 35 years.
At retirement, the early saver will have about $202,000, and the later saver, about $169,000. 
The huge advantage for the person who began saving earlier is all due to compounding 
interest.



Investing is an area in which many people feel they don’t know enough to even begin. Yet 
often they can’t afford not to invest. Regular savings accounts are perfect for that rainy-day 
fund (financial advisors recommend keeping 2–3 months worth of living expenses in a readily 
accessible bank account), but they don’t do much to keep you ahead of inflation.
Local libraries usually carry a wide variety of helpful investment magazines and books for 
beginners. You can also ask around; someone you know may have a professional financial 
planner or stockbroker that they like. Make sure the person is licensed, and ask lots of 
questions. A good advisor will make sure you understand what’s going on before you invest, 
inform you of any possible risks, and always keep your comfort level in mind when 
recommending specific investments. 



If the interest rate on your home mortgage is higher than the current rates, you can probably 
reduce your monthly payments or shorten the term of your loan by refinancing. When you 
refinance, you simply take out a new loan with new terms and use the new loan to pay off the 
old one. Then you’re left with the new loan to repay.
Fees for refinancing vary; it’s probably worth considering if you plan on living in your house 
longer than the time it takes to recover the fees. For example, if you pay a lender $2,000 in 
fees to reduce your monthly payments by $200, it’ll take just 10 months to recoup the cost, 
and by month 11 you’ll be saving money.
Remember that if you plan to hold the loan for a long time, you should also take into account 
the extra interest you’ll pay over the life of the new loan.



If you aren’t the only person who will have to live by your budget, enlist the 
opinions of the other people involved. People are more likely to support a plan 
if they’ve had a part in creating it, and the support of the people whose lives 
will be affected by a budget is critical to the budget’s success. 



If you’re budgeting toward a goal, such as a vacation or a $2,000 addition to 
your savings by the end of the year, create an expense category for saving 
toward the goal. Then include that category as a fixed expense when you’re 
figuring your spendable income.



For every category in your budget, you’ll find strategies for keeping your expenses to what 
you’ve allotted yourself, but few will be as effective as asking the following questions regularly 
and considering them thoughtfully when you’re tempted to make a questionable purchase:
1 Do I need it? 

(If yes: go to question 2. If no, don’t buy it.)
2 Can I easily substitute something I already have? 

(If no, continue. If yes, don’t buy it.)
3 Can I buy it used or recycled for less money, or even arrange a trade?

(If no, continue. If yes, look into acquiring the item second hand or bartering for it.) 
4 Is it exactly what I want, or will I have to change it or replace it soon? 

(If it’s exactly what you want, continue. If it’s not, don’t buy it until you’ve had a chance to 
look around more.)

5 If I wait three months, will I still want it?
(If yes, continue. If no, consider carefully whether it’s worth it.)

6 Will owning it make me happier or make my life better? 
(If yes, buy it! If no, take a deep breath, walk away, and be proud of your restraint.)



If you use Online Banking and have a credit card with the same bank, you can 
make managing your Credit Card Account almost effortless. You can download 
your credit card statements to your Money Credit Card Account for no extra 
fee, and your credit-card company might even categorize the transactions for 
you. In addition, you can pay your credit card using an Electronic Transfer (Xfer)
rather than a check.



If you use Online Banking for your accounts, your kids might be able to bank 
online for no extra charge if they have an account at the same bank.



By receiving a certain amount of money at a set interval, a child as young as five or six can 
begin to understand the idea of making the most of limited resources. Consider the following :
1 Most experts agree that an allowance should be a way for a child to share in the family 

resources and should not be tied to routine household chores. Many tasks, such as putting 
away toys and walking the dog, are simply part of the responsibility of being a family 
member. Extra payment for extra jobs, though, can help your children earn money beyond 
their allowances.

2 Within reason, it’s a good idea to let your kids spend their money the way they wish. Let 
kids make little mistakes with little amounts of money in the hopes that someday, when the 
stakes are higher, they’ll have learned not to make the big ones.

3 If you want your children to learn the values of saving and charitable giving, consider 
making the allowance large enough for money to be dedicated to those purposes and still 
have a meaningful amount left over.

4 As your children get older, consider increasing the amount of their allowances and at the 
same time giving them more financial responsibility. Allowances can be expected to cover 
lunch, transportation, and even clothing. It’s useful for older children to have the 
opportunity to make weightier financial decisions.

5 Pick a set day to distribute allowances, and stick to it. Paying on time is a great way to 
model fiscal responsibility. You can even put a reminder to yourself in the Payment Calendar.



This section walks you through the major steps involved in converting a 
Quicken file for use in Money. To view a complete table showing how the 
conversion handles every element of your Quicken file, look up Quicken in the 
Money online Help Index.






